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CUSTOMER AND TECHNICAL SUPPORT

Reach Us On the Web
BioFire Defense’ Web site is - http://www.BioFireDefense.com

We strongly encourage users to visit our Web site for answers to frequently  
asked questions, updated information, and additional insights into operating  
the RAZOR EX instrument.

Reach Us By E-mail
Contact BioFire Defense by e-mail in the following areas: 
	 support@BioFireDefense.com - Technical Support 
	 it@BioFireDefense.com - General Support

Reach Us By Phone
Technical support is available during the following times: 
	 8 a.m. to 5 p.m. - Mountain Standard Time

For technical support call: 
	 (801) 262-3592 - United States and Canada 
	 +1-801-262-3592 - International

International Returns
Call Technical Support for instructions on returning instruments from outside of the United States.
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ABBREVIATION OF TERMS 

-	������������������������������������negative
+	�����������������������������������positive
A	�����������������������������������amp (ampere)
BFDF	���������������������������BioFire Defense
CD-ROM	����������������������compact disk read-only memory
cm	��������������������������������centimeters
Cp	��������������������������������crossing point
DC	��������������������������������direct current
DNA	�����������������������������deoxyribonucleic acid
dNTP	����������������������������deoxyribonucleotide triphosphate
FRET	���������������������������fluorescence resonance energy transfer
F	�����������������������������������fluorescence
LED	������������������������������light emitting diode
min.	������������������������������minute
mL	��������������������������������milliliters
nm	��������������������������������nanometers
OS	��������������������������������operating system
PBS	������������������������������phosphate-buffered saline
PCR	�����������������������������polymerase chain reaction
POST	���������������������������power on self-test
PPE	������������������������������personal protective equipment
PTFE	����������������������������polytetrafluoroethylene (Teflon)
RNA	�����������������������������ribonucleic acid
sec.	������������������������������second
SNP	�����������������������������single nucleotide polymorphism
Taq	�������������������������������enzyme from Thermus aquaticus
Tm	��������������������������������melting temperature
USB	�����������������������������universal serial bus
UV	��������������������������������ultraviolet
V	����������������������������������volt
W	���������������������������������watt
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INSTRUMENT MANUAL SYMBOLS

The following symbols can be found throughout this manual. Use the definitions below as a guideline 
to interpreting the symbols.

The heat symbol identifies a potentially hot surface. To avoid bodily injury, use cau-
tion when working near hot surfaces. You should also keep flammables and com-
bustibles at a safe distance.

The warning symbol warns you to operate the instrument according to the instruc-
tions provided in this manual. If you do not, you might create a potentially hazard-
ous situation or invalidate the results.

The tips symbol tells you how to operate the instrument more efficiently.

BIOHAZARD

The biohazard symbol identifies a biohazard danger. Use standard laboratory tech-
niques when you handle pathogenic material.

The ground symbol indicates a protected ground terminal. Connect this terminal to 
ground before making any electrical connections.

All instruments shipped to the European Union (EU) have the CE label on 
the instrument. This label signifies that this instrument complies with the 
Electromagnetic Compatibility and Low Voltage Directives and the safety require-
ments for laboratory equipment.
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CHAPTER 1: 

TECHNICAL COMPONENTS

INTRODUCTION

BioFire Defense' (BFDF) RAZOR® EX instrument is a user-friendly real-time polymerase chain reac-
tion (PCR) system that requires no special lab equipment or skills. Some of its unique features that 
make it ideal for field use include the following:

•	 The instrument can run repeatedly on a rechargeable battery pack or a DC power supply. 

•	 The instrument doesn’t require a computer for operation, although data can be downloaded, 
stored, and printed on a computer using a universal serial bus (USB) or Bluetooth®. 

•	 You can easily use a needle-free syringe to insert samples into a pouch with self-contained 
freeze-dried chemical reagents. 

•	 Pouches are provided with a prep kit that includes all the necessary components to collect 
and prepare unknown samples.

•	 You can scan the bar code on the pouch to program the machine. The instrument displays 
positive calls in real time.

The technology behind the RAZOR EX instrument is based on advanced laboratory principles and 
techniques; however, the system is designed for users who have minimal laboratory experience. This 
manual provides comprehensive step-by-step instructions on how to prepare and load samples; per-
form, view, and analyze runs; perform maintenance; and troubleshoot common errors. 
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The RAZOR EX Instrument's major components

How the RAZOR® EX Instrument Works

The RAZOR EX Instrument operation is based on fluorimetric measurements and PCR. PCR uses 
heating and cooling cycles to make copies of target deoxyribonucleic acid (DNA) or ribonucleic acid 
(RNA), which are the genetic material of an organism. For more details, see Appendix A.

This instrument is designed to run 12 samples at one time in a flexible sample pouch. Each sample 
pouch contains proprietary freeze-dried reagents designed to detect specific biologic agents. These 
freeze-dried reagents contain everything needed to identify one or more specified target agents in an 
unknown sample. 

After the user prepares the reagent pouch, it is inserted into the instrument through the top slot. The 
instrument moves samples between heat zones to achieve temperature cycling. During temperature 
cycling, reagents in the pouches copy or amplify target DNA that is present. The sample pouch sits 
next to fluorimeter optics, where the instrument can take real-time fluorescence readings during the 
run. As more copies are made, the sample fluorescence increases. Over many cycles, the fluores-
cence increase has the shape of an exponential curve showing amplification of the target. 

If the organism being tested has RNA as its genetic material, reverse transcription must be per-
formed. This requires that the pouch be held at a steady temperature for an extended period of time, 
after which PCR is performed.

The RAZOR EX software makes pathogen identification simple due to its ability to make positive 
calls as they occur during the run.

The RAZOR EX can do multiple runs and analyses as a hand portable instrument in the field. The 
instrument can run and store 75 runs before management of the run data is necessary. After using 
the instrument, you can download the run data to a computer for storage, review, and printing.



< 3 >RAZOR® EX < > Operator’s Manual

Chapter 1: Technical Components

Display Keypad

Push 
Buttons

LCD Screen

 Note: To turn off instrument, select Shut Down from the main menu.

Button name Function
Power Turns power on (press for 5 sec.) 
Brightness Controls brightness of the LCD screen display
Arrow Back Takes user back to the previous screen
Arrow Up Allows user to scroll up in a screen
Arrow Down Allows user to scroll down in a screen
Select Selects highlighted option on the screen

Running a Pouch in a RAZOR 

91°

60°

91°

60°

Denaturation
Liquid pushed up, sample heated

Annealing
Liquid pushed down, sample cooled

Inserting Pouch
Instrument pre-heated

91°

60°

Optics
Block

Seal Bar for
Sealing Top
of Pouch

Sample Pouch

Pneumatic Bladders 
for Opening and 
Closing Heating and
Cooling Bars

Schematic of a sample pouch inserted into a RAZOR instrument

The above cross-section of the RAZOR EX shows how the instrument moves samples between heat 
zones. The reagent pouch is described in more detail below.
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RAZOR EX Instrument Reagent Pouches 
Plunger (load 
position)

Plunger Comb

Sample Inlet 
Ports

Freeze-dried
Reagent

Sample Slot

 Negative 
Controls

 Positive 
Controls

  Unknown 
Sample 2

 Unknown 
Sample 1

Yeast

A Sample 4 x 3 Pouch with Key Parts Labeled

RAZOR ® 11+1 10 Target Screen

Anthrax

Brucella spp.

Botulism
 A

Coxiella

E. coli O157

Tularem
ia

Ricin

Salm
onella

Sm
allpox

Plague

ICPC

Inlet Port
Inlet Port

A Sample 11 + 1 Pouch (The 10®)  
 

Well

Closeup of the Pouch Bottom

The RAZOR EX reagent pouches are made of thin, clear, flexible plastic attached to a semiflexible 
loading body. The clear plastic provides a large surface area to allow for rapid heat exchange and 
efficient fluorescence monitoring. Preparation of the sample pouch does not require a centrifuge or a 
pipette, making it ideal for field use. Liquid or powder samples are collected, prepared in liquid, and 
inserted into the pouches with syringes. When the syringe is inserted into the inlet port, the correct 
amount of the liquid sample is drawn by vacuum into the sample pouch. The reagent pellet, freeze-
dried inside each well, dissolves upon contact with the liquid sample. Each vacuum-sealed sample 
pouch contains freeze-dried reagents. Pouches also include a square bar code for programming the 
instrument and a rectangular bar code that contains lot and serial numbers. The pouch comes with 
a sampling kit for liquids, powder, or surfaces, as well as a loading kit containing syringes, sample 
buffers, and reagent grade water.
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Equipment Specification

Sample Description •	 12-reaction capacity
•	 Plastic reaction pouch
•	 Pouch dependent (see directions for each reagent pouch)

Fluorescence Acquisition •	 Single-color optic module
•	 Blue LED excitation with peak emission of 470 nm

Power Supply •	 24-V 4-A external power supply (included)
•	 Rechargeable battery pack (included); 4 runs per charge when 

instrument is run at temperatures between 0°C and 40°C

Power Input •	 100 V to 240 V, 47–63 Hz, 1.5 A

Dimensions and Weight •	 Approximate size (W x D x H):  
26 x 11 x 19 cm (10.25 x 4.5 x 7.50 in.)

•	 Weight: 4.9 kg (10 lb 12 oz)

Performance Parameters •	 Instrument setup time ≤ 5 min.
•	 Optional reverse transcription step
•	 Reverse transcription + PCR in less than 45 min.

User Interface •	 Bar code reader to load run-specific information
•	 Color screen, large membrane push-button interface

Data Output •	 Real-time display of fluorescent readings
•	 USB 2.0 support and Bluetooth for data download and archiving
•	 Automatic analysis with end-of-run interpretive calls
•	 Real-time positive calls

Environmental Parameters

Description Specifications
Ambient temperature required to maintain 
specifications during operation

0°C to 40°C (32°F to 104°F)

Humidity 20% to 60%, noncondensing*

Altitude Sea level to 3048 m (10,000 ft)

Shipping/storage conditions -10°C to +60°C (14°F to 140°F)

*Condensation can be damaging to the instrument. If removing the instrument from long-term cold 
storage, warm the instrument gradually to prevent condensation.
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CHAPTER 2: 
INSTALLATION AND  
SETUP

INTRODUCTION
This chapter describes the following:

•	 Setting up the instrument
•	 Battery charging
•	 Power connection
•	 Loading protocols
•	 Pouch preparation 

INSTALLATION OF THE RAZOR® EX  
INSTRUMENT
 
Installation Requirements
The requirements for space and power are: 

•	 13 x 9 in. (about 33 x 23 cm) of space 

•	 24-V 4-A power supply  or a rechargeable battery pack (included with the instrument)

Setup Conditions
For operation, select a clean, well-ventilated area that is large enough for both the instrument and 
the computer (if using a computer). 

 Note: Even when using the power supply, run the RAZOR EX with the battery installed to guard 
against unexpected power failures and intermittent or poorly regulated power.

 Note: Cold temperatures may decrease the battery life.

 CAUTION: When you use the instrument, the instrument and the pouch will be hot. 
Handle both the instrument and pouch with caution.
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Setting Up the Instrument
1.	 Unpack the RAZOR EX instrument from the carrying case and set it on a solid, flat surface. The 

battery is separated from the instrument to prevent the battery from depleting during storage. 

 Note: Save the boxes and shipping material that accompany the instrument so that you can 
package it correctly if you ship it for maintenance or repair.

2.	 Slide the battery into position on the bottom-right side of the instrument and confirm that the 
locking pin slides into place. Use the directional arrows on the side of the battery and instrument 
as a guide for sliding the battery onto the tracks.

 Note: The instrument stand may need to be collapsed to slide on the battery.

 Note: If the internal components have been serviced by the user, confirm that the internal 
movable heater is closed and locked into place before you turn on the instrument. Refer to 
Chapter 4, Maintenance and Troubleshooting, “Accessing Heater Bars and Optic Lenses,” for 
more information.

3.	 Unlock the lid by sliding the lid latch to the right.

4.	 Open the protective lid.

Lid Latch

Lid Catch
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5.	 Press and hold the Power button for 5 sec. to turn the instrument on. The screen will activate 
and display its current status. The instrument performs a 40-sec. self-diagnostics test when 
turned on. If the machine generates an error message, refer to Chapter 4, Maintenance and 
Troubleshooting.

6.	 Adjust display lighting by pressing the Brightness button , which is located next to the 

Power button.

POWER INPUT
The RAZOR EX instrument can be powered by the supplied RAZOR EX battery or by external power 
using the 24-V power supply provided with the instrument (Note: This is the same supply that is used 
to recharge the battery). If you connect both power sources, you can hot swap between the RAZOR 
EX battery and external power. If external power is plugged in, the instrument will use this power as 
its default.

External Power Supply
1.	 Plug the 24-V power supply into a grounded power source.

2.	 Connect the other end to the RAZOR EX power port by lining up the red dots and pushing the 
locking connector into the power port receptacle. To remove the cable, retract the knurled collar 
on the plug. 

�����

��

�����

Battery Maintenance
The RAZOR EX battery allows approximately 4 runs when fully charged at 25°C ambient. Be sure 
to charge the battery before taking the instrument into the field. If the battery power is low, a prompt 
from the instrument will advise you to charge the battery or switch to the power supply.  

 Note: The battery will allow 4 runs per charge when runs are performed in temperatures 
between 0°C and 40°C. If the instrument is operated in environments above or below that range, the 
number of runs per charge may differ.

Battery Level Indicator
The RAZOR EX contains a battery level indicator. This can be viewed at the bottom of the Utilities 
menu before a run, in the pouch prompt steps during analysis initialization, and in the status window 
during a run.  The number of solid white boxes indicates the approximate number of runs remaining, 
e.g., three runs remain in the example below.
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 Note: If external power is attached to the instrument, the battery indicator will be grayed out.

Battery Removal
 WARNING: Unless the instrument is plugged in, do not change a battery while the machine is 

running. If you have to change a battery mid-run, plug in the 24-V power supply to the external port 
first or you will lose the run data. IF YOU LOSE THE RUN DATA, YOU CANNOT RECOVER IT. 

1.	 Locate the locking pin on the lower left side of RAZOR EX and pull the pin down to unlock the 
battery.

2.	 Slide the unlocked battery out from the machine. An instrument stand will release from the bot-
tom to support the instrument.

Recharging Batteries
 Note: Keep the vent on the recharger free of obstruction.

1.	 The instrument will alert you when the batteries need to be recharged.

2.	 Turn the instrument off by selecting Main Menu > Shut Down. 

3.	 After the RAZOR EX turns off, remove the battery by pulling the pin down and sliding the battery 
off the bottom of the instrument.

4.	 Line up the battery and the recharger. Slide the battery onto the recharger using the directional 
arrows on the side of the battery and recharger as a guide. 

5.	 Plug the 24-V power supply into a grounded AC power source and connect the other end to the 
recharger. When the recharger is plugged in, the red light will come on. 

6.	 Allow the battery to charge. The green light blinks while the battery is charging. When the battery 
charge is full, the green light will be solid.
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 Note: A fully depleted battery takes approximately 8 hours to fully charge. 

 Note: The battery does not charge when operating a plugged in RAZOR EX.

SAMPLE HANDLING
BIOHAZARD  HAZARDOUS MATERIAL: Use standard laboratory procedures when you handle biohazardous 

material. Sample pouches are made of plastic and, if damaged, could cause contamination. 
Consider all samples biohazardous and carefully dispose of pouches and syringes in a biohazard 
waste container.

 Note: When you handle and load samples, avoid contamination problems by using standard 
laboratory techniques and following appropriate protocols for loading samples. Change gloves fre-
quently to avoid cross-contamination of samples.
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reagent pouch is disposable and contains all of the ingredients for real-time fluorescent detection of 
target nucleic acid using the RAZOR EX system. Each pouch has a unique serial number and corre-
sponding rectangular bar code. The unknown samples for the RAZOR EX are loaded in liquid form 
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Protocols are preprogrammed in the square bar code printed on the assay kit box. Use the bar code 
reader to scan them into the instrument. If you prefer, you may scan the protocols into the instrument 
before you take the RAZOR EX to the field. 
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You will also need to verify that the run protocol for this test is loaded onto the instrument before you 
load the sample into the pouch by scanning the rectangular bar code printed on the sample pouch 
label. If the protocol has not been loaded before the rectangular bar code is scanned, a message 
appears that prompts you to load it.  

GENERICB-GENB0001 GENERICB-GENB0002 GENERICB-GENB0003

GENERICB-GENB0004 GENERICB-GENB0005 GENERICB-GENB0006

GENERICB-GENB0007 GENERICB-GENB0008 GENERICB-GENB0009

GENERICB-GENB0010 GENERICB-GENB0011 GENERICB-GENB0012

GENERICB-GENB0013 GENERICB-GENB0014 GENERICB-GENB0015

GENERICB-GENB0016 GENERICB-GENB0017 GENERICB-GENB0018

GENERICB-GENB0019 GENERICB-GENB0020 GENERICB-GENB0021

GENERICB-GENB0022 GENERICB-GENB0023 GENERICB-GENB0024

GENERICB-GENB0025 GENERICB-GENB0026 GENERICB-GENB0027

GENERICB-GENB0028 GENERICB-GENB0029 GENERICB-GENB0030

1.	 To load the protocol, select Main Menu > Utilities by using the Up and Down arrows and the 
Select buttons. Confirm the steps in the next section by following the screen instructions.

2.	 Scan the square protocol bar code found on the box. You may scan more than one protocol. 
The bar code reader is the camera lens at the back of the instrument.

 

Bar Code 
Reader

3.	 After you scan all of the correct protocol bar codes, return to the Main Menu by selecting Back. 
See Chapter 3 for instructions on loading the pouch bar code information.

 Note: Be sure that all bar codes are as smooth and flat as possible.
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 Note: During the scan, the bar code reader emits a bright green aiming beam surrounded by 
red light. Hold the bar code approximately 6–8 in. from the back of instrument and move the bright green aim-
ing beam close to the bar code to scan. If you hold the bar code more than 8 in. away from the reader, 
you will need to center the green aiming beam on the bar code to scan. When the scan is com-
plete, the aiming beam turns off and the instrument will display the message, “Loading Barcode 
Data.” If the scan does not complete within 15 sec., flatten the image and/or move the bar code 
gradually closer to the instrument to scan it.

6–8 in.

LOADING PROTOCOLS WITHOUT A BAR CODE
If the square (protocol) bar code is not available or not functioning, users have the option of selecting  
a generic protocol on the RAZOR EX. 

1.	 From the Main Menu, select Run w/o Barcode. This will bring up the Select Protocol screen.

2.	 Scroll through the available protocols and select the one that applies.
3.	 Once a protocol has been selected, the user will be taken to the Remove Old Pouch screen. 

Follow the screen instructions from this point on to prepare and load the sample onto the 
RAZOR EX.

 WARNING: The bar code on each pouch includes critical information such as lot numbers. You 
should always run a pouch using its bar code when you are able.
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POUCH PREPARATION
The following instructions are for a typical pouch loading example (4 x 3 format). For specific instruc-
tions for each pouch, see the RAZOR Pouch Instruction Booklet and assay card supplied with each 
test kit.

 Note: Always ensure that you use the supplied control and sample buffers. Using nonsupplied 
buffers may result in the controls and/or samples failing.

You need the following materials to prepare a pouch. 
RAZOR pouch containing freeze-dried reagents 
in a foil bag

Syringes with tips

Unknown sample bottles Reagent grade water or control buffer bottles
Sample swabs Transfer pipettes

Sample Handling
Sampling should be done before reagent preparation. Each sample must be in liquid form before 
running PCR. Sample preparation is essential because samples must be free of any contaminating 
salts or other compounds that would disrupt or inhibit the enzymatic reactions and fluorescent dyes 
required to run the reaction. 

Dry Sample (Powders, etc.)						    

SNA
P!

1.	 Touch the dry swab to the unknown powder or swab a 2 x 2 in. area 
of solid surface.

2.	 Place the swab into the appropriately labeled vial and break off at 
break point.

3.	 Secure the cap on the vial and shake vigorously for 30 sec.

4.	 If dilution is NOT necessary, proceed to the “Reagent Pouch 
Loading” section.

5.	 Repeat for the remaining samples using a fresh swab and correctly 
labeled vial.

Liquid Sample (Automatic air samplers, etc.)					          

1.	 Transfer approximately 0.5 mL of liquid to the appropriately labeled vial.

 Note: To draw a sample with the transfer pipette, first squeeze and hold the 
top of the bulb. Insert the tip of the pipette into the liquid and release the bulb to 
draw sample up to the fill line (see illustration). Transfer the pipette to the vial and 
squeeze the bulb to empty the sample into the vial.

2.	 Secure the cap on the water vial and shake vigorously for 30 sec.
3.	 Repeat for the remaining samples using a fresh pipette and appropriately labeled 

vial.
4.	 If further dilution is NOT necessary, proceed to “Reagent Pouch Loading” section.

 
 

Top of bulb

Fill liquid to here
(about .5 mL)

Fill liquid to here 
(Approximately 
0.5 mL)

Top of 
bulb
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Dilution
For a sample that might contain a high level of inhibitors, a dilution step may be necessary. To per-
form a dilution on a dry or liquid sample, follow these steps:

1.	 Add sample to a vial as described in the previous two sections.
2.	 Transfer approximately 0.5 mL from the vial to another labeled vial (i.e., Diluted Sample 1) 

using a transfer pipette.
3. 	 Secure the cap and shake vigorously for ~30 sec.
4. 	 Load both the undiluted and diluted samples into a pouch using the “Reagent Pouch Loading” 

section.

Once the raw sample has been prepared properly, load the sample into the pouch.

Reagent Pouch Loading
 WARNING: Do not open the pouch until you are ready to scan the rectangular bar code 

and load the sample. Once opened, you must use the pouch within 30 min., or the pouch will 
lose vacuum and will not pull in the correct volume of sample.

1.	 Confirm that the foil bag is air tight. If the bag is not air tight, contact BFDF Technical Support, 
because reagents may have been compromised.

2.	 Open the foil bag and remove the freeze-dried reagent pouch from the aluminum can.

3.	 Place the pouch on a flat, clean surface with the inlet ports and label face up. Make sure the 
plunger comb is in place.

Loading a Syringe
 WARNING: Do not prepare syringes until indicated by the instrument pouch prompts. 

1.	 Uncap the end of a syringe. The end of the syringe is preloaded with a tip necessary for RAZOR 
EX freeze-dried pouch loading. If you have syringes without the preloaded tip, load the tip onto 
the syringe using aseptic technique (avoid touching the tip to other surfaces).
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2.	 Insert the tip end of the syringe into reagent grade water or the prepared sample.

3.	 Draw reagent grade water or the sample into the syringe by pulling up on the syringe plunger 
until it reaches the appropriate mark (see the assay card for specific instructions):  

•	 0.5 mL for a 4 x 3 format 

•	 0.2 mL for a 12 x 1 format

•	 2.0 mL for an 11 + 1 format (The 10® pouch) 

•	 0.35 mL for a 6 x 2 format 

Avoid introducing any air into the syringe, which can cause bubbles.

 WARNING: If there are air bubbles in the syringe, DO NOT remove them by tapping and then 
pushing bubbles out of the tip into the air (this could contaminate both you and your area). Instead, 
reinsert the syringe into the sample vial and slowly express the liquid. Slowly redraw the sample into 
the syringe. Repeat until the liquid in the syringe is free of air bubbles.

Sample Insertion
Follow the prescribed order below to minimize cross-contamination and errors. You may also use the 
loading instructions located on the assay card.

Step 1
Negative 
Controls 

Step 2
Unknown 
Sample

Step 3
Positive/
Inhibition 
Controls
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Plunger (load 
position)

Plunger Comb

Sample Inlet 
Ports

Freeze-dried
Reagent

Sample Slot

 Negative 
Controls

 Positive 
Controls

  Unknown 
Sample 2

  Unknown 
Sample 1

Yeast

A Sample 4 x 3 Pouch with Key Parts Labeled

The procedure is essentially the same for loading the negative controls, the unknown samples, and 
the positive controls.

1.	 Load a syringe with the correct volume. Refer to the section named “Loading a Syringe” for 
instructions on how to correctly load a syringe. Fill the syringe with the correct fluid for the inlet 
port you want to fill.

•	 For the Negative control inlet port, you will insert reagent grade water or control buffer. 
The appropriate bottle will be provided with your pouch.

•	 For the Unknown Sample inlet ports, you will insert the correct unknown sample. Repeat 
for remaining unknown samples.

•	 For the Positive control inlet port, you will insert the reagent grade water or control buffer. 

•	 For the Inhibition control inlet port (if present), you will insert the correct unknown sample.

The illustration below shows the syringe being inserted into a Negative inlet port.

 

2.	 After you prepare the syringe, hold it by the syringe body and gently insert the tip into the cor-
rect inlet port. Push the syringe down until you feel a faint pop and an ease in resistance. This 
indicates that the seal on the inlet port has been broken. A broken inlet port allows the liquid to 
be pulled into the pouch by vacuum. Allow the syringe to sit in the inlet port for at least 30 sec. 
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to allow the liquid to dispense evenly. Once the syringe plunger has stopped moving, remove the 
syringe and discard it into a biowaste container. If the liquid does not flow into the pouch auto-
matically, the pouch might be damaged. Consult the “Pouch Troubleshooting” section in Chapter 
4, Maintenance and Troubleshooting, for more information about what to do.

CAUTION: DO NOT push the syringe plunger to force liquid into the pouch. This can fill the 
pouch with air and may damage the pouch or cause contamination. 

3.	 After you have emptied all of the syringes into the reagent pouch, confirm that all of the dried 
reagents have dissolved in the liquid. 

Undissolved 
reagents

Dissolved 
reagents

If the reagents are dissolving slowly, shake the pouch gently by hand. If they fail to dissolve, con-
tact BFDF Technical Support.

Removing the Comb and Plunging
 WARNING: Depressing the pouch plungers when the pouch is not in the pouch bracket may 

damage the pouch, prevent the sample from entering the sample slot, or cause backflow leading 
to contamination. If at any time during the preparation process you suspect that the exterior of the 
pouch became contaminated with any suspected biohazardous materials, be sure to wipe off the 
pouch with 10% bleach (one part chlorine bleach and nine parts water) before inserting it into the 
RAZOR EX. This will help prevent contamination of the instrument’s internal components which may 
result in erroneous test results.

 Note: Be sure that the outside of the pouch looks clean before you insert it into the instrument. 
If the pouch looks unclean, gently wipe it with a dry, lint-free cloth.

 Note: When you handle and load samples, avoid contamination problems by using standard 
laboratory techniques and following the appropriate protocols for loading samples. Change gloves 
frequently to avoid cross-contamination of samples.

 Note: DO NOT push pouch plungers down until step 4.

1.	 Remove the plunger comb(s) by pulling it away from the pouch.
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2.	 Twist plunger by using the plunger twist tool or the end of the plunger comb and rotate each of 
the plungers 90º towards the center of pouch; this prevents leaking and cross-contamination 
of neighboring wells. You can also rotate the plungers by hand or with a small flat-head screw-
driver. 

		

3.	 With the pouch plungers up, lightly tap the pouch on a flat surface.

Bracket

4.	 To plunge the pouch, place the pouch onto the plunge bracket located near the pouch slot on the 
instrument. Holding the reagent pouch in the bracket, slowly push the pouch plungers down to 
force the liquid into the individual sample slots. When all of the plungers have pushed liquid into 
the sample pouch, the samples are ready to be run.  
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CHAPTER 3: 
RUNNING A POUCH AND 
THE SYSTEM SOFTWARE

INTRODUCTION
The RAZOR® EX software is designed for the basic user. The instrument screens will guide the user 
through each step of preparing, loading, and running samples in the pouch.
This chapter describes the following applications for the RAZOR EX:

•	 Loading the run information

•	 Preparing the reagent pouch

•	 Inserting the pouch into the RAZOR EX

•	 Performing the run

•	 Analyzing the results

•	 Downloading the results to a computer

This chapter contains the following main sections:

•	 Scanning the pouch and initiating a run: Includes instructions for loading the pouch infor-
mation by scanning the reagent pouch, inserting the pouch into the RAZOR EX, and per-
forming the run. 

•	 Reviewing results: Explains how to interpret the format of the test results you will see on 
the screen of the RAZOR EX after you finish a run. 

•	 Instrument utility menus: Gives you an understanding of how to transfer information from 
the RAZOR EX to a computer. You can also delete files, scan protocol codes, view logs, set 
the date and time, and view the software version. 

•	 RAZOR EX desktop software: Explains details of the desktop software and how to interact 
with the RAZOR EX. 

•	 Qualitative Detection analysis: Explains crossing points and controls and how they are 
used in test results reporting.

•	 Reports: Explains how to create and print a test report.

•	 Change history and audit trail information: Explains data storage and how to create audit 
trails. 
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•	 Managing database contents: Explains how to copy items and how to rename, delete, and 
export files.

•	 Charts: Explains how to use charts. 

•	 User accounts and system access: Explains account management and system access. 

SCANNING THE POUCH AND INITIATING A 
RUN
Scanning a reagent pouch and performing a run consists of the following parts: 

1.	 Scanning the pouch bar code.

2.	 Following the preparation instructions for the pouch and the instructions on the screen after 
the RAZOR EX initiates the run. 

Scanning the Pouch Bar Code
The RAZOR EX instrument displays instructions on the screen to walk you through the steps of 
scanning a reagent pouch and performing a run. Each reagent pouch has a unique serial number 
that is also encoded in a rectangular bar code, as shown in the following picture.

1.	 Select Main Menu > Run Pouch to start the loading instructions.
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2.	 When Scan POUCH Barcode displays, scan the rectangular pouch bar code from the reagent 
pouch labeling by holding it vertically and as flat as possible in front of the bar code scanner 
(located on the back of the instrument). The pouch should be approximately 6 to 8 in. from the 
scanner. Press Back to abort the bar code scan.
If the bar code is not scanned immediately, flatten the bar code or move it closer to the scan-
ner. If the bar code is not read in time, the reader will abort the scan. Press Select to return to 
the Main Menu, then select Run Pouch again.

Bar Code Reader

 Note: If the bar code does not scan properly, the message Aborting Barcode Scan, will dis-
play. If you scan the wrong bar code, the message Invalid Barcode Data (Barcode Should Be 
Rectangular) will appear.You should then scan the rectangular bar code on the pouch’s fitment 
label. If any bar code becomes smeared or unscannable, generic codes are available on the assay 
card and in Appendix G.

3.	 If the bar code is scanned correctly, the screen displays Loading Barcode Data.  

 Note: If the correct protocol is not present on the instrument, the machine will prompt you to 
scan the square protocol bar code from the labeling on the outer box. 

4.	 After you scan the bar code, the instrument begins preheating. The preheating time depicted 
on the screen depends on the current temperature of the instrument. An instrument at room 
temperature (18–30ºC) requires approximately 8 min. to preheat. When it is complete, a mes-
sage will appear that says Preheat Complete. Press Select to continue.

 Note: Do not tear the pouch when you remove it during the next step; the contents could con-
taminate the instrument and surrounding area.

BIOHAZARD  HAZARDOUS MATERIAL: Use standard laboratory procedures when handling biohazardous 
material. Consider all samples biohazardous and carefully dispose of pouches and syringes in a bio-
hazard waste container.
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5.	 The instrument displays the message Remove Old Pouch. Remove the pouch from the previ-
ous run and discard it as biohazardous waste. 

6.	 Press the Select button to continue.

7.	 The instrument displays an Inject All Ports screen. Load the syringes and inject the ports as 
described in Chapter 2, Installation and Setup.

8.	 When you have injected the ports, press the Select button to continue. A Preheating screen 
displays with information about the case temperature. To stop the run, press the Select button. 

Once preheating is complete, the instrument displays a Preheat Complete window. Press the 
Select button to continue.

9.	 Follow the remaining pouch prompts to help you prepare your pouch for testing. For more 
details, see “Pouch Preparation” in Chapter 2, Installation and Setup.
After pressing Select, the Analysis Initiation screen displays.

10.	 Select Proceed. 
An Insert Pouch screen displays.
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11.	 Insert the prepared pouch into the instrument with the label facing up and the plungers toward 
the front of the instrument. The pouch fitment should sit perfectly in the groove over the insert 
slot. After you insert the pouch, press the Select button. 

The PCR Runtime Menu screen displays. 

The PCR Runtime Menu
Unless you choose to quit by selecting PCR Runtime Menu > Quit PCR, the instrument will begin 
PCR. You can leave the screen at the current display during PCR, or you can select the progress 
screens listed on the PCR Runtime Menu to view the progress of the run or the status of the instru-
ment. Select the Back button on any of the progress screens to return to the PCR Runtime Menu.
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MONITORING PCR PROGRESS
View Realtime Graph
To view the progress of the run on a graph, select View Realtime Graph. View Realtime Graph 
provides a graph that displays the curves of each sample. Slot numbers are displayed at the top of 
the screen. You can use the up and down arrows to highlight specific samples. The screen also dis-
plays positive (+) and negative (–) detector calls. A positive (+) call indicates presence of the specific 
reagent target. A question mark (?) will be indicated until such time as a positive (+) call is deter-
mined or the run is completed. At this point the negative (-) call will be displayed if no amplification is 
detected.

View Slot Labels
View Slot Labels displays the name and slot position of the pouch reagents. This information is 
uploaded in the square protocol bar code.

View Progress
View Progress displays a screen that lists the pouch serial number, the protocol, the estimated time 
to completion, cycle status, and estimated power. The power source used (External or Battery) will 
be bright, and the one not used will be dimmed.
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View Status
View Status displays a screen that shows the current heating and cooling temperatures of the run 
and instrument air pressure. The A and B heaters are the denaturing heaters at the top; C and D are 
the annealing heaters on the bottom.

 Note: Return to the run-time menu by pressing the Back arrow.

Quit PCR
The Quit PCR menu item stops the PCR run. 

RESULTS
When a run is finished, the screen automatically displays a Results (Summary) screen with the 
metacalls for the run. These results rely on the Detector software algorithm to determine the pres-
ence or absence of the target being tested.

Detector
Detector is an advanced mathematical algorithm that determines if each slot in the pouch has detect-
able amplification (that is, whether copies were made of the target DNA). Slots are called indepen-
dently of each other. Detector runs in real time on the instrument: strongly positive slots are called 
while the machine runs, and the Detector calls at the top of the screen are updated. Negatives are 
not called until the run is over. 

Calls Meaning of each call

+ The software has detected an amplification curve for a slot position.

– The software has not detected an amplification curve for a slot position

? The software has not determined the correct call yet.
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Metacalls
The Metacalls program takes the Detector calls for individual slots and gives you combined informa-
tion about unknowns and assay controls (see Qualitative Detection Analysis in this chapter for an 
explanation of controls). Protocols contain all the necessary information for results, summaries, and 
details. This information is specific to the reagents present in the pouch and their configuration. 

REVIEW RESULTS SCREENS
To access specifics about the metacalls, select the Back button from the Results (Summary) screen.

Three choices of viewing results are then displayed, as well as the pouch number, the name of the 
protocol, and the date and time of the run:

•	 Results (Summary): displays combined calls (Metacalls) for unknowns and controls. This 
screen comes up immediately after a run.

•	 Results (Details): specific results for any control failures.

•	 View Graph: A graph of the test results

Results (Summary)
The following screen is an example of what you will see when you look at a summary of results. The 
top green section of the screen contains the screen title in the first line and a slot map in the second 
line. The slot map starts with ‘1’ (slot 1) on the left side of the line and ends with ‘12’ (slot 12) on the 
right side of the line. Between 1 and 12 there are four groups of three characters each. Each charac-
ter represents one of the slots from 1 to 12. In this particular screen, you can see a plus symbol and 
a minus symbol, which are Detector call symbols. Plus symbols show that amplification was detected 
in the slot.
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The 11+1 (The 10®) screen above shows a positive test result for the first unknown sample (Anthrax) 
and positive results for the PCR Inhibition and Positive Control slots. The first line identifies the 
assay.  

Results (Details)
Results (Details) shows the summary call along with the call for each slot. However, if there are no 
metacalls, the Results (Details) screen will display “No Metacalls Found.” Also, if a control fails, the 
test has failed, and the software will not display the metacalls.

The Detector calls for each slot are shown in green at the top of the screen. Again, the first slot num-
ber (1) is listed on the left, the last slot number (12) is listed on the right, and twelve symbols repre-
senting the detector calls for the 12 slot numbers are sandwiched in between. The screen contains 
the masks for each pouch slot. The Detector masks the test results using a mask that was desig-
nated in the protocol, then displays the appropriate message. 

For the masks, the possible results are shown in the following table. 
Calls Meaning of each call

* Call is not relevant

–  Call is negative

+ Call is positive

The Detector call for the same slot can generate multiple messages.

In the mask for Anthrax Detected for Unknown 1:
•	 The mask has the number 1 on the left and the number 12 on the right. In between are 

twelve characters, arranged in four three-character groups. 
•	 The first group of symbols, + * *, represent slots 1 through 3. In this pouch, these slots con-

tain the sample slots for anthrax, Brucella, and botulism A. To generate the result text for this 
particular example and to match the mask, slot 1 must be positive since it is the sample slot 
for the anthrax assay. 

•	 The second group of three symbols, * * *, masks the test results for Coxiella, E. coli, and tula-
remia. Since the detector call is not relevant to the detection of anthrax, the mask shows 
only asterisks in these slots.

•	 The third group of symbols, * * *, masks the test results for ricin, Salmonella, and smallpox. 
This group also had no relevant calls and shows only asterisks.

•	 The fourth group of symbols, *++, represent slots 10 through 12. Slot 10 represents plague 
and displays an * as there were no relevant calls. Slot 11 is for the inhibition control and slot 
12 is for the positive control. These both display a positive call indicating that there are no 
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inhibitors and the positive control amplified properly. To generate the result text for this par-
ticular example and to match the mask, slot 11 must be positive to show that there is no inhi-
bition and slot 12 must be positive, since it is the positive control for the anthrax assay.  

  
The following examples shows the results of four test runs. The table identifies the wells, assays, 
and reagent types. The text following the table shows the test results for this table. The Detector 
calls are listed first, followed by the summary of results and the details. 

Examples of Test Run Results
Example 1—Anthrax Pouch
In this specific example, one unknown straight and one unknown with a dilution was tested for three 
anthrax assays (target 1, target 2, and target 3 . In this run, the Positive Controls failed. Wells 10, 11, 
and 12 were all negative but should have amplified and been called positive.

Identification 1st Set of Wells 2nd Set of Wells 3rd Set of Wells 4th Set of Wells

Well 1 2 3 4 5 6 7 8 9 10 11 12

Assay Ant 
T1

Ant 
T2

Ant 
T3

Ant 
T1

Ant 
T2

Ant 
T3

Ant 
T1

Ant 
T2

Ant 
T3

Ant 
T1

Ant 
T2

Ant 
T3

Reagent Type Negative Control Unknown 1 Unknown 1 Dilution Positive Control

Detector Calls are --- --- --- --- 
Summary Metacalls
Pos Control Failure
Ant T1-Run New Pouch

Pos Control Failure
Ant T2-Run New Pouch

Pos Control Failure
Ant T3-Run New Pouch

Details Metacalls
Pos Control Failure
Ant T1-Run New Pouch
1 *** *** *** *-* 12

Pos Control Failure
Ant T2-Run New Pouch
1 *** *** *** **-12

Pos Control Failure
Ant T3-Run New Pouch
1 *** *** *** **-12

Control Failure
Positive
1 *** *** *** -** 12
2 *** *** *** *-* 12
1 *** *** *** **- 12 
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Example 2—11 + 1 Test Run Results (The 10®)
The following example shows the results of a test run, where the reagents are in a 11 + 1 pouch. 
The table identifies the wells, assays, and reagent types. The text following the table shows the test 
results for this table. The detector calls are listed first, followed by the summary of results and the 
details, if applicable. 

In this specific example, an 10-target screen kit was used to test one unknown. The results show the 
following: 1) the PCR Positive Control worked; 2) the PCR Inhibition Control worked, 3) Coxiella (well 
4) was detected in Unknown 1, and 4) no other assays were detected.

Identification 1st Set of Wells
2nd 

Set of
Wells

Well 1 2 3 4 5 6 7 8 9 10 11 12

Assay Antx Bru Bot A Cox E coli Tul Ricin Salm Smpx Plag PCR PCR

Reagent Type Unknown 1 Inhibition 
Control

Positive 
Control

Detector Calls are --- +-- --- -++
Summary Metacalls
Coxiella Detected

Details Metacalls
Coxiella Detected
1 *** +** *** *++ 12
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Example 3—10 + 2 Test Run Results
In this specific example, an 8-target screen kit was used to test one unknown. The results show the 
following: 

•	 Positive controls for RT and PCR worked. 
•	 Inhibition controls for RT and PCR both failed. 
•	 No assays were detected potentially because the sample contained inhibitors possibly prevent-

ing amplification. 

Identification 1st Set of Wells 2nd Set of
Wells

Well 1 2 3 4 5 6 7 8 9 10 11 12

Assay A B C D E F G H RT PCR RT PCR

Reagent Type Unknown 1 Inhibition 
Controls

Positive 
Controls

Detector Calls are --- --- --- -++ 
Summary Metacalls
Control Failed
Inhibition Control

Details Metacalls
Control Failed
Inhibition Control 
1 *** *** *** -** 12
1 *** *** **- *** 12

Control Failure
PCR Inhib. Control
1 *** *** **- *** 12

Control Failure
RT Inhib. Control
1 *** *** *** -** 12 
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Example 4—11 + 1 Test Run Results (The 10®)
In this specific example, a 10-target screen kit was used to test one unknown. The results show the 
following: 

•	 Positive control for PCR worked. 
•	 Inhibition control for PCR failed. 
•	 Coxiella amplified. The sample contains inhibitors possibly preventing amplification.
•	

Identification 1st Set of Wells
2nd 

Set of
Wells

Well 1 2 3 4 5 6 7 8 9 10 11 12

Assay Antx Bru Bot A Cox E coli Tul Ricin Salm Smpx Plag PCR PCR

Reagent Type Unknown 1 Inhibition 
Control

Positive 
Control

Detector Calls are --- +-- --- --+ 
Summary Metacalls
Coxiella Detected
Presume UNK+, IC Fail

Details Metacalls
Coxiella Detected
Presume UNK+, IC Fail
1 *** +** *** *-+ 12

Control Failed
Inhibition Control
1 *** *** *** *-* 12

For this pouch, Assay 4 has a presumptive positive, so appropriate action can be taken while the 
same sample is run on a new pouch to confirm that no other agents are present. This process is 
similar if a positive control fails but the inhibition control is detected.
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View Graph
This screen displays the full amplification graph with Detector calls at the top of the screen. You can 
use the up arrow  and the down arrow  to highlight specific samples. When you highlight a sam-
ple, the number and detector call are outlined, and the curve appears with a thicker white line.

FINISHING THE RUN
 

BIOHAZARD  HAZARDOUS MATERIAL: Use standard laboratory procedures when handling biohazardous 
material. Consider all samples biohazardous and carefully dispose of pouches and syringes in a 
biohazard waste container. When the run is finished, carefully remove the pouch and dispose of it 
as biohazardous waste. Do not allow the bag to tear; the contents of a finished run can contami-
nate the instrument. Run another pouch or turn the RAZOR EX off by selecting Main Menu > Shut 
Down. 

Caution Hot  CAUTION: When the RAZOR EX is finished, the instrument and pouch will be hot. Use 
caution when you handle the instrument and pouch after a run.

Opening Previous Runs
To look at the results of a previous run, select Main Menu > Review Results. 

A Sort Results Files window displays. 
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This window allows you to organize the data according to the parameters you want. You can sort by 
the date of run, the protocol used, and the serial number of the pouch in the orders shown. Runs 
are sorted by the first parameter, then the second parameter, and so on. The following list shows the 
same  possible ways of organizing your data that are also shown in the Sort Results File screen 
above. 

•	 Date/Protocol/Pouch#

•	 Protocol/Date/Pouch#

•	 Date/Pouch#/Protocol

•	 Protocol/ Pouch#/Date

•	 Pouch Number

These parameters sort in the following way: 
•	 Date sorts list files starting with the most recent.

•	 Protocol sorts alphabetically by protocol name. 

•	 Pouch Number sorts by serial number. For example: A0000001 to Z9999999.

After you sort the file, highlight the file you want by using the up or down arrows, then press the 
Select button. 

The run will open in the screen:

You will then have the same Results viewing options that appear at the end of a run. A computer can 
perform more analyses by downloading run data from the RAZOR EX and examining the fluores-
cence curves and the detector calls with the RAZOR EX Desktop Software. 
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INSTRUMENT UTILITY MENUS
The instrument's Utility menu allows you to select a PC connection (USB or Bluetooth), delete files, 
scan protocol codes, view logs, set the date and time, view the battery life, and view the software 
version for the instrument.

To access the Utility menu, select Main Menu > Utilities. 

The following screen will display:

 Note: At the bottom of this screen is a battery level indicator. If the display shows only two white 
bars or less, you will need to recharge the battery before performing the run.

Select PC Connection
The PC Connection option gives you the option of connecting to a PC with the USB cable that 
comes with the equipment or by Bluetooth®  with your own module and software. Choose Select 
Utility > Select PC Connection.

On the Select PC Connection menu, select either Via USB or Via Bluetooth. 
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USB
1.	 Plug the USB cable into the RAZOR EX and the computer you want to use.

�����

��

�����

2.	 Select Connect to PC Via USB.

 Note: If the computer does not recognize the RAZOR hardware device when initially connected 
by USB, use the Windows “Add Hardware Wizard” to confirm the USB drivers. The Wizard can be 
found in the Control Panel under the Add Hardware icon.

Bluetooth

1.	 Select Connect to PC Via Bluetooth.  

 
2.	 When Bluetooth is enabled, a yellow wireless icon will flash in the top left-hand corner of each 

screen.
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Yellow icon

 Note: Bluetooth models vary; check the device manual for specific instructions. 
3.	 To connect from the PC, open the Bluetooth program. 
4.	 Search for wireless devices. When the RAZOR EX is detected, connect to it as a serial device. 

The instrument name will appear after it is connected to the instrument.  
This can be repeated for multiple RAZOR EX instruments. 

 Note: Users can only connect to one instrument at a time. To view a different instrument, you 
must disconnect and connect to another RAZOR EX.

Delete File
This selection allows users to delete “single results,” “all results,” a “single protocol,” or “all proto-
cols.” It also has a sort feature that allows you to sort files to delete them. For more information 
about the sorting feature, see the “Finishing the Run” section in this chapter.

Scan Protocol Code
Use this option to scan the protocol codes before you begin a run. A red warning will display if the 
wrong type of bar code is used (such as the rectangular pouch bar code instead of a square proto-
col bar code), the system is unable to read the bar code, the data is invalid, or the protocol memory 
is full. For more details, see Chapter 2, Installation and Setup.

View Logs
This option allows you to view or delete the ERROR and STATUS Logs. The error log displays mes-
sages from the instrument, including date and time, error code, and error description. ERROR and 
STATUS Logs are critical to troubleshooting and may be requested by Technical Support.

Set Date and Time
This allows you to set the time and date. To move the date or time forward, use the up and down 
arrows to highlight the + option (i.e., + Day), and then press the Select button repeatedly to reach 
the correct date or time. To move backward, use the up and down arrows to highlight the – option 
(that is, – Hour) and then press the Select button.

View Software Vers.
This option provides the date and time of the versions for each of the major RAZOR EX instrument 
software components.
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RAZOR EX DESKTOP SOFTWARE
The RAZOR EX software allows you to perform and analyze test runs. The data (including run analy-
sis and user accounts) is stored separately in a database called Exor.

Installing on a Windows 7 Computer or Windows 8 Computer
When using Windows 7 or 8 the driver must be installed before the RAZOR EX software. Contact 
support@biofiredefense.com to obtain the Windows 7 or 8 driver. 

If the RAZOR EX software has already been installed on Windows 7 or 8 without the correct driver 
follow these steps:

To install the Windows 7 or 8 driver:
1.	 Uninstall Exor3 (making sure that it is not active in your system tray).

2.	 Uninstall the RAZOR Software.

3.	 Delete the following file:  C:\Program Files (x86)\IdahoTech.

4.	 Delete the following file that contains the RAZOR drivers:  C:\Program Files (x86)\Silabs.

5.	 Uninstall the Idaho Tech RazorEX (Driver Removal).

6.	 Restart your computer.

7.	 Download the Razor-VCP6.4.zip file from the filedrop site provided by  
BioFire Defense customer support. This file contains the VCP installer  
and all the associated files together.

8.	 Move the Razor-VCP6.4.zip file from your download list to your desktop. 
 

9.	 Launch the VCP installer. 
 

mailto:support@biofiredefense.com
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10.	 Reinstall RAZOR EX software and Exor3 as described in the next section.

11.	 Launch Exor 3 and RAZOR EX software.

12.	 Connect to RAZOR EX instrument.

If the RAZOR EX software has not been previously installed:

13.	 Download the Razor-VCP6.4.zip file from the filedrop site provided by  
BioFire Defense customer support. This file contains the VCP installer  
and all the associated files together.

14.	 Move the Razor-VCP6.4.zip file from your download list to your desktop. 
 

15.	 Launch the VCP installer. 
 

16.	 Install the RAZOR EX software and Exor3 as described in the next section. 

 Note:  When connecting a RAZOR EX using Windows 7 be consistent with the type of con-
nection used. BioFire Defense recommends using USB only. It has been found that when switching 
between USB and Bluetooth in Windows 7 the software will stop responding to both. For questions 
contact support@biofiredefense.com.

mailto:support@biofiredefense.com
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Installing the RAZOR EX Software
1.	 Load the RAZOR EX software using the CD provided with the instrument. A file menu will display. 

 

2.	 Select RazorSetup.exe from the file menu. A Welcome screen will display. Select Next.

3.	 The InstallShield Wizard will display. Select Next to start the Wizard. 
 

 

4.	 When the InstallShield Wizard has completed installing, click Next. The End User License 
Agreement will display. Read through the agreement. If you agree with the terms, select Yes. 
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5.	 A message will display asking you where you want the RazorSW software to be located. Either 
use the browse window to select a location or use the displayed default location by selecting 
Next.

6.	 The wizard will then allow you to choose which icons are added for the software.

7.	 If the Exor database has not been installed on your computer, the Exor InstallShield Wizard will 
begin installing.

8.	 After Exor has been installed, the software install will then launch the install for the correct USB 
drivers.

Starting the RAZOR EX Software
1.	 Start the RAZOR EX instrument, then start the computer connected to the instrument accord-

ing to the setup instructions in Chapter 2, Installation and Setup.
2.	 Verify that the double-arrow database icon appears in the system tray, which is in the lower 

right corner of your desktop.
The icon indicates that the database management software (called Exor) has started. You can 
also start the database by opening the Start menu, then selecting Programs\IdahoTech\Exor3.

3.	 A login dialogue box opens. 

4.	 Enter your user name and password, leave Traceable in the Log on to: box, and then click 
Login.
The default user name is admin and the password is master.

 Note: You will need to change your password the first time you log in.
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The front screen for the RAZOR EX software opens. 

 

The front screen displays two buttons:
•	 Connect to Razor: This button allows users to move files from the RAZOR EX to a com-

puter. This requires a connection between the instrument and computer (that is, USB or 
Bluetooth).

•	 Analysis: This button allows users to view files that have already been stored in the soft-
ware database. 

5.	 Click one of the buttons, or to work with items already in the database, select View > 
Navigator. Navigator displays the contents of the database in a tree list to the left of the front 
screen.

Connecting to the RAZOR EX Software
To view RAZOR EX files, you must first connect to the RAZOR EX instrument to download test runs, 
save them to the computer’s hard drive, and then import them into the software.

1.	 Connect to the instrument by selecting Main Menu > Utilities > Select PC Connection. 
Choose USB or Bluetooth, and then either connect the USB cable or find the device with your 
Bluetooth software.

2.	 Click Connect To Razor on the front screen

3.	 The software opens a dialogue box, Searching for Razor Instruments, and a progress bar. If 
any RAZOR EX instruments are connected to the computer and powered on, the software will 
detect them. If the software does not find any RAZOR EX instruments, it displays a message.  

4.	 If the software detects RAZOR EX instruments, the Searching dialogue box will disappear. 
Select the correct I/O port from the I/O port drop down menu.
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5.	 The serial number of the instrument appears in the Instrument Name box after you select the 
correct I/O port.

 Note: You MUST select the I/O port for the instrument name to appear. 

This button copies files from the instrument.

This button copies files and then deletes them from the 
RAZOR EX. 

6.	 A browse window opens, allowing you to select the location where you want to save the files. 
The preferred location for RAZOR EX files is c:\Program Files\IdahoTech\RazorSW\Data. 

 

7.	 A dialogue box appears with a progress bar as the software copies the files. After all the files 
are copied, the dialogue box disappears. 

8.	 A new dialogue box will now appear asking if you wish to import the data. Selecting Yes will 
take you to the batch import function (see “Importing a Directory of Files” in the next section).

9.	 If you do not wish to import files, you may select No. You may then connect to another RAZOR 
EX and repeat the process to download runs or copy files.
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IMPORTING FILES
To view analytical run information in RAZOR EX Software, the test file must be stored in the RAZOR 
EX software database. Therefore, if run files from the RAZOR EX are currently stored on a hard 
drive or a diskette, you have to import the files into the database. Importing a file copies the file into 
the database; it does not remove the file from the original location. You have to import an .RZ4 file 
into the RAZOR EX software, which creates an .ixo file so you can view the file, print the file, or cre-
ate a report. Creation of the .ixo file does not remove or delete the .RZ4 file.

Run Names
The default run name is formatted as follows: 

serial number of the instrument_protocol_date_pouch serial number.RZ4  

The RZ4 file extension designates RAZOR EX files from the instrument. For example, the run name 
RAZOR-EX1024_Training_2006-10-20_A0000003.RZ4 is a run on instrument 1024 with the Training 
Protocol on 10/20/2006 using pouch A0000003.

Importing Selected Files
You can import one or more selected files by using the File > Import command. 
To use the Import command to import files do the following:

1.	 From the RAZOR EX software, select File > Import, then select the correct type of file as fol-
lows: 
•	 For RAZOR EX Software files, select RZ4 Files. 
•	 For RAZOR III Software files, select Object .ixo Files. 

2.	 Select the files you want to import.
RAZOR EX files are stored on the local hard drive at c:\Program Files\IdahoTech\RazorSW\Data 
(or a different location if the person who downloaded the data selected something other than the 
preferred location). The run name includes the instrument serial number, protocol, and pouch serial 
number, which makes it easy to locate files.

To select multiple files, press Ctrl while selecting the file names or press Shift to select consecutive 
files.

3.	 Click Open.

 Note: These files have been imported into the software, but have not been saved in the 
RAZOR EX database.

4.	 To save the currently displayed file in the RAZOR EX Software database, click Save, select the 
folder to store the file in, then click Save. You cannot save a file to a folder where it already ex-
ists unless you either rename it or replace the original file. 

5.	 To save each of the remaining imported files (if any), click the file name in the task bar to make 
the file active in the work pane; click Save, select a folder, then click Save. 
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Importing a Directory of Files 
1.	 From the RAZOR EX software, select File > Batch Import. 

The Batch Import dialogue box displays.

2.	 Click Add.

3.	 Find and select the directory you want to import, then click OK.
•	 The directory path is added to the window.
•	 The default location for RAZOR EX files is c:\Program Files\IdahoTech\RAZORSW\Data 

(or a different location if the person who downloaded the data selected something other 
than the preferred location). 

4.	 Check Include subdirectories if you want to include the subdirectories of the directory.

5.	 Repeat Steps 2–4 to add additional directories as needed.

6.	 To remove any of the paths you have added:
•	 Click in the Remove column for the file. The software displays a gray button.
•	 Click the button to remove the file.

7.	 Repeat the process to add more directories.

8.	 When you are finished adding directories, click Next.

9.	 Select the folder in the database where you want to store the imported files, then click Next.

10.	 Scroll down to and select the type of file to import. RAZOR EX files are .RZ4 files, and RAZOR 
III files are .ixo object files.

11.	  Select the action for duplicate files.

12.	 The next tab displays the current status of the imported files. Any failed imports will have in-
formation reported in the Messages column. Maximizing the window and resizing the columns 
will allow you to read long messages. You cannot save a file to a folder where it already exists 
unless you either rename it or replace the original file. 
When all the files have been imported, view the results on the Import Done tab.

13.	 To redo the import with different import parameters:
•	 Click Previous twice to return to the Start Import tab.
•	 Click Reset. 
•	 Change the parameters you want, then click Next to re-import the files.

14.	 When you are finished, close the dialogue box by clicking Done on the Import done tab.
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UNDERSTANDING THE SOFTWARE WINDOW
Follow the procedure below to open any saved test. The example below illustrates the software fea-
tures and components described in the rest of this section.

Opening a Test
1.	 Log on to the RAZOR EX software. (The computer does not need to be connected to an instru-

ment for you to view a finished and imported test.)

2.	 Select View > Navigator.

3.	 In Navigator, click the plus sign (+) next to the Analytical Runs folder. 

4.	 Double-click the test name; for example, RAZOR-1001_ANTRAX97_2007-05-07_15-37-29_
A9700016.R24.

5.	 A Summary tab displays general test information including run notes, which contain the meta-
calls results (summary and details) from the run.

6.	 Select the Raw Data tab to view the test data. The tab displays a list of samples and charts of 
test data. 

The figure below illustrates the Raw Data tab of the software window containing information from a 
demonstration test.  
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The Software Window

Menu Bar
Global Toolbar

Work Pane

Module Bar

Task Bar
Status Bar

The software window contains the following areas: 
•	 Navigator: The Navigator tree structure organizes and displays folders and files of users, 

instruments, and tests.

•	 Menu bar: The menu bar contains menus used to access data and perform software func-
tions.

•	 Global toolbar: The global toolbar at the top of the window contains buttons for common 
tasks.

•	 Work pane: The work pane is used to perform the specialized operations of the software, 
such as viewing data or analyzing results.

•	 Module bar: The module bar provides access to the components of a test. It is visible only 
when a new or saved test is opened.

•	 Task Bar: The task bar displays icons for all open windows, including ones “hidden” behind 
the current window.

•	 Status bar: The status bar displays the name of the current user and computer.

•	 Messages window: The message window displays any messages generated as you use the 
software. 

The following sections describe the main areas of the RAZOR EX software window in more detail. 
This includes the following areas of the software window: Navigator; the menu bar and global 
toolbar; the work pane; and the module bar. In addition, the following sections also contain informa-
tion about showing or hiding items under a folder, managing items, and how to close or reopen the 
Navigator. 
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Navigator
To open the Navigator, select View > Navigator. 

The Navigator, on the left side of the RAZOR EX software window, provides access to items stored 
in the RAZOR EX software database. Items are organized into folders in a tree structure and always 
include the following default folders:

•	 Administration folder: Contains user groups, user roles, user accounts, and security poli-
cies. This folder is not editable.

•	 User folders: Contains folders and default subfolders for each user account. The default 
subfolders include Analytical Runs, Preferences, Special Data, and Templates and Macros. 
You can also create your own subfolders.

•	 IdahoTech folder: Contains objects anyone can view and use. This folder can be used by 
anyone with access to RAZOR EX software. (To modify an item, you must first copy it to 
your own user folder.) 

Showing or Hiding Items Under a Folder
Double-click the folder name or click the plus (+) or minus (–) sign next to the folder.

Managing Items
•	 Right-click an item name in the Navigator to display a context, and then select a command.
•	 The menu commands vary, depending on the type of item and your user account privileges.

Closing and Reopening the Navigator
1.	 To close Navigator, choose one of the following: 

•	 From the View menu, deselect Navigator.
•	 Click the X in the upper-right corner of the Navigator pane.

Closing Navigator causes the work pane to extend the full width of the window.
2.	 To reopen the Navigator, select View > Navigator.
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The Menu Bar and Global Toolbar 

The menu bar and the global toolbar are located at the top of the software window. Many of the but-
tons duplicate the commands found on the menus. If a button or menu item is inactive (dimmed) 
either it is not available, or the task does not apply to the item that is currently open.

Menu Use 
File •	 Create new files, open files, and close files.

•	 Save items.
•	 Log out of the software (without closing the software).
•	 Import and export individual files or batches of files.
•	 Open a test report. 
•	 Print the current window.
•	 Exit (close) the software.

Edit •	 Cut, copy, and paste data in the work pane or items in the Navigator.
•	 Select all items.

View •	 Display or hide these sections of the RAZOR EX software window: global toolbar, 
task bar, status bar, Navigator, and messages. 

•	 Display the Front Screen (the window you see after you first start RAZOR EX soft-
ware).

Tools •	 Change your password.
•	 Manage user accounts (create, disable, change names and passwords).
•	 View database status, including a list of logged-in users and information about the 

query engine (see “Updating the Database,”  later in this chapter).
Window •	 Close, minimize, and arrange windows when multiple windows are open in the 

work pane.
•	 Select an open window to make it the active window. (The bottom of the Window 

menu displays a list of all currently open windows, with the active window 
checked.)

Help •	 Display online versions of RAZOR EX software manuals.
•	 Open the About window to view version and copyright information about the soft-

ware.

Button Use
Create a new item. A dialogue box displays icons for all available items; select the 
correct item.
Open any item. A popup navigator opens so you can select the item you want. 
(You can also double-click an item in the main Navigator to open it.)
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Button Use

Save changes made to an item. The software enables the Save button only when 
the item in the active window has been modified.

Generate a test report and display it in a test report window. 

The Work Pane
The RAZOR EX software work pane contains information specific to the operation you are perform-
ing. For example, if you open the Run module of a saved test, the work pane displays three tabs: a 
Programs tab containing the program protocol, an Online Data Display tab containing the raw data 
returned from the instrument during a run, and a Run Notes tab where you can enter information 
about the test. 
The application is designed to allow multiple open tests or other items. A label for each open item is 
visible in the task bar at the bottom of the window. Click the label in the task bar to display the item 
in the work pane. 

To size individual sections of an item in the work pane:
1.	 Drag the horizontal borders between sections to size them.

2.	 Click the handle on the border of a section to hide or show the section.

The Module Bar
The module bar displays the following icons for the components of a test. It is visible only when a 
new or existing test is open.

Button Use
Opens the Summary module of the test run, which contains information about the 
run—such as name, date, owner—and charts of raw data generated during the 
run.

Opens the Run module, which includes the details of the run protocol, charts of 
raw data returned during the run, and notes entered by the person running the 
test.

Opens the Samples module, which contains general sample information, such as 
sample names and assays tested.

Opens the associated analysis module. This is the icon for a qualitative detection 
analysis.
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To use the module bar:
1.	 Click an icon to open the module.

Or
Use the keyboard shortcut for the icon, Ctrl+Shift+N, where N is the number of the icon count-
ing from the top. For example, the Samples icon is always third in the list of icons, so to open the 
Samples module, press Ctrl+Shift+3.

2.	 Hold the mouse pointer over an icon to see the name of the related module and the keyboard 
shortcut for opening the module.

QUALITATIVE DETECTION ANALYSIS
The Qualitative Detection analysis module analyzes unknown samples for the presence of a nucleic 
acid target based on the presence or absence of a crossing point (Cp) in each sample’s data. The 
RAZOR EX Software uses the Qualitative Detection analysis to generate results. 

 Note: Temperature graphs are not imported for RAZOR EX files; only the temperature at the 
fluorescence acquisition is displayed.

Crossing Points

Cp

In an amplification reaction, the point in the cycle at which the target DNA has amplified enough so 
that its fluorescence is visible above the background fluorescence is called the Cp of the sample. It 
appears as a sharp upward turn in the sample’s curve on a fluorescence chart.

Assuming that there is no contamination, a Cp indicates the presence of the target DNA and is 
expressed in cycles. Crossing points are used by the Qualitative Detection modules to determine 
the presence or absence of the target DNA. Samples are listed by name showing their positions and 
color on the graph.
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Controls 
Control samples provide information about the quality of the reagents, sample contamination, inhibi-
tors, and reaction conditions. Controls are expected to behave in a certain way. If they fail to behave 
as expected, then the results for the unknown samples are considered invalid. 

•	 Positive control (PC). A positive control contains a known concentration of a nucleic acid 
sequence and should have a Cp value that is characteristic of the sequence. The posi-
tive control is located in a separate slot from the unknown samples. Its result applies to all 
the slots for the specified assay in the run. If the positive control does not amplify, then the 
control fails. Failure may be caused by PCR inhibitors contaminating the sample, damaged 
pouch or reagents, or user error. 

•	 Negative control (NC). A negative control does not contain any target DNA sequence and 
should not have a Cp. The negative control is located in a separate slot from the unknown 
samples. Its result applies to all the slots for the specified assay in the run. If the negative 
control amplifies, then the control fails. Failure indicates that the control is contaminated and, 
therefore, that unknown samples may also be contaminated. 

•	 Inhibition control (IC). An inhibition control contains a known concentration of a DNA 
sequence and should have a Cp value characteristic of the sequence. The sample is added 
to the inhibition control to determine whether inhibitors are present that would stop a sample 
with template present from amplifying. The inhibition control is located in a separate slot from 
the unknown samples. Its result applies to all the slots for the specified assay in the run. If 
the inhibition control does not amplify, then the control fails. Failure may be caused by PCR 
inhibitors contaminating the sample, damaged pouch or reagents, or user error.

Understanding the Results 
Results for each slot include a section labeled Calls and a section labeled Results. The Target col-
umn displays the amplification result for the slot position based only on the slots amplification profile. 

Value Explanation of the Target Column
Positive Amplification was detected in the slot.

Negative Amplification was not detected in the slot.

Target Call A positive or negative call for the slot based on amplification curve. Calls are 
made by Detector (which is part of the RAZOR EX instrument).

Results columns show the following:
Contents Comments
Cp The sample crossing point, in cycles.

Max Fluor  
(Background)

The level of fluorescence increase determined by subtracting baseline fluo-
rescence level from highest level of fluorescence reached by the sample.

You can highlight individual samples by selecting them with the mouse. To view multiple samples,  
hold down the Ctrl key while selecting samples you want to examine or Shift for consecutive sam-
ples.
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VIEWING AND PRINTING A TEST REPORT
This section contains information about the following subjects:

•	 Generating a test report
•	 Viewing and printing the report
•	 Regenerating a report

Generating a Test Report
The test report contains the following information:

•	 Sample names and detector calls for each slot
•	 Test information (such as a run name, start and stop time, and date)
•	 A graph of the amplification curves
•	 Metacalls from the instrument including results (summary) and results (details)
•	 Assay information with results for each assay’s controls
•	 Instrument information, including the serial number
•	 Pouch information with the pouch serial number and protocol name

1.	 Open the test or click Save. 

2.	 Click Report, or select File > Report. The report window opens in the work pane.  
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3.	 To see additional pages of the report, use the page forward and backward controls:

To change the scale of the report within the window, click one of the three buttons on the top 
left of the report screen:

•	 Left: The report is displayed at its printed size.

•	 Middle: The entire report page fits in the window.

•	 Right: The width of the report page fits in the window.

To print the report, click Print:

To close the report, click the X above the report toolbar.

Viewing and Printing the Report
Use the report controls in the report tool bar as described on the previous page.

Regenerating a Report 
You cannot save a report, but you can easily regenerate the report for any test:

1.	 Open the test and make any necessary edits.

2.	 Click Save. You must save the test before you can create a report.

3.	 Click Report on the global toolbar, or select File > Report. The report window opens in the 
work pane and can be modified as described above.

CHANGE HISTORY AND AUDIT TRAIL  
INFORMATION 
The RAZOR EX desktop software runs in Audit Trail mode. An audit trail allows revisions and chang-
es to each test to be stored and accessed. 
Audit-trail mode imposes the following limits:

•	 In audit-trail mode, it is impossible to overwrite or delete tests or analyses.

•	 You cannot copy a test or save a test with a new name. Names for test records must be 
unique within the database.

•	 The audit trail stores the following information about each saved version of a test: date, 
operator, change notes, and revision number.
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Revisions
Change notes are required for every change after the completion of the test and analysis. Previous 
revisions of the test are saved in the database as read-only information. You can change only the lat-
est revision of a test, and you can only change a limited number of fields. These include the sample 
names and sample notes. 
To view revisions:

1.	 Open the test and select File > Revisions
A Revision list opens, displaying the revision number, date, the user name, and the reason for 
the change.

2.	 To open a previous revision, double-click on the correct selection. The previous revision of the 
test opens in the work pane with the number of the revision appended to the front of the run 
name.

3.	 To generate a report, click Report in the global toolbar.   

Change Notes
Whenever you attempt to save a test that you have modified 
(for example, by adding sample notes or run notes), the soft-
ware prompts you to enter change notes. Informative and 
detailed change notes are essential to the audit trail process. 
For each change, enter the following:

1.	 The name of the person making the changes
2. 	 Specific changes that were made
3. 	 The reasons for making the changes

These change notes are the major record detailing the revi-
sions of test. You cannot save a test without entering change 
notes.

MANAGING DATABASE CONTENT
This section describes how to manage the data that is stored in the RAZOR EX database (Exor) and 
is visible in the Navigator.

Copying Items
You can copy an item from another person’s folder into your own folder or subfolder. However, your 
user role may limit which folders are visible to you and which items are available. 
Once the item is in your own folder, it becomes your item, and you can modify it as necessary (sub-
ject to the limitations of your user role). For example, you might want to copy a sample preference 
file from another user’s folder into your own preferences folder and then modify it. 
To copy items from another person’s folder:

1.	 Right-click the item you want to copy in the Navigator, then select Copy.
A dialogue box opens.

2.	 Select your user folder (or a subfolder under your user folder), enter a new name for the item if 
you want to do so, then click OK. 
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Exporting Files
To store test runs or other data outside the database or to transfer data between databases, you 
must export the data. Exporting data does not remove it from the database, but copies it into an .ixo 
file and stores it at the location you designate.
An exported test is stored as a file with an .ixo extension. You can also export a run’s raw data (its 
temperature and fluorescence measurements) in text format (a file with a .txt extension) and export 
other items, such as chart preferences. Like tests, preferences have .ixo extensions.

Exporting an Individual Item
1.	 In RAZOR EX software, open the run to be exported. The item must be open in the work pane 

before it can be exported.

2.	 Select File > Export.

3.	 Navigate to a location to save the exported file, make sure that XML Object Files (.ixo) is se-
lected as the file type, enter a new file name (or keep the existing name), and then click Save. 	
The file is saved with an .ixo extension.

Exporting a Test’s Raw Data
1.	 In RAZOR EX software, open the test containing the data you want to export.

The item must be open in the work pane before you can export it.
2.	 Select File > Export.

3.	 Navigate to a location to save the exported data, select Raw data file (.txt) as the file type, 
enter a new file name (or keep the existing name), and then click Save.
The text file contains the raw fluorescence and temperature values for each data acquisition 
point in the test. You can use any text editor, such as Notepad, to open the file.

Exporting a Folder of Items
1.	 Select File > Batch export. The Batch export dialogue box is displayed.

2.	 In the folder tree, highlight the folder containing the items to export. 

3.	 Leave Scan Sub-folders selected if you want to include subfolders in the export. 

4.	 Click Next.
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5.	 Click Browse to display a file selection dialogue box.

6.	 Find and select the location in which to store the exported files, then click OK.

7.	 Click Next.
A tab with export options is displayed.

8.	 Select the object types to export. 

9.	 Select the date range for the objects by creation date or modification date.

10.	 Select the operation to perform if a file should already exist with the same name as a file being 
exported. 

11.	 Click Next.
The tab displays a summary of the export paths (from and to).

12.	 If the paths are correct, click Next to begin the export. (Otherwise, click Previous to return to 
previous tabs and make corrections.)
The export begins. The tab displays the current status of the export operation for each file. 
Maximizing the window and resizing the columns allows you to read long messages. 
When all the files have been exported, the Export done tab is automatically displayed.

13.	 View results on the Export Done tab, then click Done to close the dialogue box.

Updating the Database
If you install an updated version of software, you may see a message instructing you to update the 
database. Follow the steps below (all other people must be logged out of the database before you 
can update it.):

1.	 Select Tools > Database Status.

2.	 Check that there are no user names displayed in the Logged In Users tab.
•	 If other people are logged in, you must ask them to log out or wait until a time when no 

one is logged in. 
•	 If no one else is logged in, select the Query Engine tab, and then click Update. 
•	 The system displays a message to remind you that the update will take several minutes.

3.	 Click Yes to clear the message and continue. 
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After the database is updated, a message states that the update is complete.
4.	 Click OK to clear the message. 

A message on the Query Engine tab states that the query engine is now up to date.
5.	 Close the Database Status dialogue box.

USING QUERIES 
RAZOR EX software includes a query tool you can use to search for and retrieve test runs and other 
items stored in the software database.

Creating and Executing a Query
1.	 Click New, select the Query icon, and then click OK.

The Query window opens in the work pane.

2.	 In the Object Type box, select the type of item to look for, such as Analytical Run (a test).

3.	 (Optional) Enter the Name of the item to search for or the Owner of the item, if known.

4.	 Select Modified Date or Creation Date to specify which type of date you want to use in the 
query.

5.	 Select a date range. 
You can specify the number of months or days before the current date to search, or you can 
select a beginning and ending date.

6.	 Click Search. 
Results are displayed to the right of the search criteria. The results include the following:

•	 Item name 

•	 Item type

•	 Date the item was created

•	 Date the item was last modified

 Note: If an error message is displayed stating that the query engine needs to be updated, you 
must update the database. See previous section, “Updating the Database.” 

7.	 To open an item, double-click the item name. 
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8.	 To save the query, click Save. 

9.	 Enter a name and select a location (or leave the defaults), and then click Save.
Saving a query lets you quickly reexecute the search without needing to respecify the search 
parameters. 

10.	 To close the search window, click Close.

Executing a Saved Query
1.	 Find the query you want in the Navigator. 

The default location for saved queries is the Query folder under the Special Data folder for 
your user account.

2.	 Double-click the query name to open the query in the Query window.

3.	 In the Query window, click Search to execute the query.

Specifying Default Paths and Folders
You can specify default paths and folders for the following: 

•	 Default directories for importing and exporting files.

•	 Default database folders in which to save RAZOR EX software items such as test runs, pref-
erences, and queries.

To specify default paths and folders:

1.	 In the Navigator window, select Preferences under your user folder and open the User pref-
erences subfolder.
The User preferences tabs are displayed in the work pane. The Directories tab is active. 

2.	 In the Import from box, type a path to a location on your local computer or network. 
Or
Click “…”, then navigate to a location on your local computer or network and click OK. The 
path will become the default location from which to import files into the database. 

3.	 In the Export to box, type a path to a location on your local computer or network. 
Or
Click “…”, then navigate to a location on your local computer or network and click OK. The 
path will become the default location that is displayed when you export files from the data-
base.

4.	 Select the Folders tab.
A row is displayed for each type of item you can store in the database, such as experiments 
(tests) or queries.

5.	 On each row, type a path to a subfolder under your database user folder. 
Or
Click “…” then navigate to a folder under your user folder. Click OK.
The folder will become the default location for storing items of this type.

6.	 Click Save to save all of your preferences.
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CHARTS
Using Charts
The RAZOR EX software allows you to zoom in to view chart details and to print, export, and copy 
charts and their data. 

Zooming
1.	 Display the chart you want to see.
2.	 Place the cursor above and to the left of the chart area you want to enlarge.
3.	 Click and drag the mouse pointer down and to the right (the pointer changes to a rectangle.) 

Release the mouse button when the rectangle covers the area you want to see. The area with-
in the rectangle expands to fill the work pane. 

4.	 Repeat Steps 2 and 3 as often as necessary until the chart details are as large as you want.
5.	 To restore the chart to its original size, click and drag the mouse pointer up and to the left. (Do 

this only once to restore the chart to its original size.)
To print the entire window, select File > Print Window. 

Printing Only a Chart Image
1.	 Display the chart you want to print.

2.	 Right-click within the chart boundaries and then select Print.
A set-up window is displayed.

3.	 To change the size of the chart, click and drag the gray margin lines that surround the image.

 Tip: You can resize the dialogue box to adjust the chart margins more easily. 
4.	 If necessary, select a printer. (Your default Windows printer is automatically selected.)

5.	 To change printer configuration options, click Setup. 
A standard Windows printer setup dialogue box is displayed. Enter the necessary information, 
then click OK.

6.	 Select Portrait or Landscape.

7.	 Click Print.
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Exporting a Chart Image as a File
1.	 Display the chart you want to export. 

2.	 Right-click within the chart boundaries, and then select Export. 
An Export Chart dialogue box opens.

3.	 On the Picture tab, under Format, select the graphic format for the exported chart.

4.	 If an Options tab is displayed (on the right), select conversion options as needed. 
The tab is not displayed for all graphic formats. If the tab is displayed, the options vary, 
depending on the format you selected.

5.	 To change the size of the exported image, select the Size tab, then enter the new width and 
height values. Select Keep aspect ratio if you want to maintain the proportions of the chart.

6.	 Click the button labeled “…” (to the right of the Filename box).

7.	 Browse to the location where you want to save the exported chart image, enter a name for the 
image, and then click Select. 

8.	 Click Export to export the chart image.

Exporting Chart Data as a File
1.	 Display the chart containing the data you want to export. 

2.	 Right-click within the chart boundaries, then select Export. 

3.	 Select the Data tab.
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4.	 In the Series box, select the data item you want to export.
The items vary, depending on the chart type.

5.	 In the Include box, select the text labels to export with the data.
•	 Point Index: Adds a number to each row

•	 Point Labels: Identifies the acquisition points in each sample

•	 Header: Provides informational data for each row

6.	 In the Format box, select a format for the exported data.
•	 Text: The data is exported as a .txt file

•	 XML: The data is exported as an .xml file

•	 HTML Table: The data is exported as an .html file

•	 Excel: The data is exported as an .xls (Microsoft Excel) file

7.	 If you selected Text as the format, select a delimiter (that is, a data separator) in the Delimiter 
box. The default delimiter is Tab.

8.	 Select the button labeled “…“ (to the right of the Filename box).

9.	 Browse to the location where you want to save the exported data, enter a name for the data 
file, and then choose Select. 

10.	 Select Export to export the data.

Copying a Chart Image or Chart Data
1.	 Display the chart you want to copy.

2.	 Right-click within the chart boundaries, then select Copy to clipboard. The chart is saved as a 
bitmap, and the data is saved as text. 

3.	 To paste the chart image, open a graphics application such as Paint, then copy the image us-
ing the application’s Paste command. 

4.	 To paste the chart data, open a text editor such as Notepad, then copy the data using the ap-
plication’s Paste command. 
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USER ACCOUNTS AND SYSTEM ACCESS
The level of access you have to software features depends on the role assigned to your User 
Account in the RAZOR EX software. The system has two account types, admin and operator. The 
admin user account has an administrator role. There is only one admin account, and it is created 
automatically when the software is installed. The admin user creates the other user accounts. All 
other user accounts, except the admin account, have the operator role.
The table below describes software features available to operators and to the admin user. 

Task Operator Admin
Create and modify your own subfolders and files X X
Connect to instruments X X
View tests and other objects belonging to other users X X
Modify files belonging to other users X
Create, modify, and disable user accounts X
Import and export files X X
View and print reports X X

MANAGING USER ACCOUNTS
Only the admin user can manage user accounts. 

Creating a New User Account
1.	 Select Tools > Manage Users.

2.	 Click New User.

3.	 Enter a full name.

4.	 Enter a login name (the default is the full user name)

5.	 Enter a temporary password (the user will be prompted to change the password upon first 
login).

6.	 Reenter the password.

7.	 Select the Operator role from the drop-down list.

8.	 Click Done.
A folder is created for the new user, and the new user account is listed in the User Management 
window.

Editing a User Account
1.	 Select Tools > Manage Users.

2.	 Select a name in the window and click the Edit User button, or right-click the name and select 
Edit User from the drop-down menu.

3.	 Modify the user information, as needed.

4.	 Select Done.
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Disabling a User Account
1.	 Select Tools > Manage Users.

2.	 Select the name in the window and select the Edit User button, or right-click the name and 
select Edit User from the drop-down menu.

3.	 Check Access Disabled. 

4.	 Select Done.
The user account is no longer active, but it still exists in the database. 

MANAGING SYSTEM ACCESS
Only the admin user can view or change system access settings.

Setting Auto-Logout
1.	 Select Tools > Manage Users.

2.	 Select Edit Access.

3.	 Under Logout on Inactivity, select Enabled.

4.	 Click the arrows in the Minutes of Inactivity box to specify the number of minutes of inactivity 
that should occur before someone is automatically logged out of the database. 

5.	 Select Done.

Disabling User Access after Invalid Login Attempts
1.	 Select Tools > Manage Users.

2.	 Select Edit Access.

3.	 Under Disable Access on Invalid Password, select Enabled.

4.	 Click the arrows in the Maximum Login Attempts field to specify the number of times some-
one can attempt to log in before account is deactivated.

5.	 Select Done.

Setting Password Expiration
1.	 Select Tools > Manage Users.

2.	 Select Edit Access.

3.	 Click the arrows in the Password Expiration Days field to specify the number of days some-
one’s password remains valid, counting from the day the password is created.

4.	 Select Done.
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VIEWING APPLICATION ERROR MESSAGES
Error messages generated by the software can be displayed in a message pane at the bottom of the 
RAZOR software window.

To display the messages pane: 

1.	 Select View > Messages. The software displays the messages pane at the bottom of the window.

2.	 Double-click an error message in the message pane to display a pop-up containing the message.

3.	 Click Details to display additional information about the error. 

4.	 If you plan to contact BFDF Technical Support, copy and paste the detailed information into 
a text editor (such as Notepad) so that it is available to support personnel. You should also 
provide the .ixo file for troubleshooting and indicate what was being attempted when the error 
occurred.

5.	 Click OK to close the message pop-up.
Error messages are also logged in an application error log file located at C:/Program Files/
IdahoTech/RazorSW/Data/RazorErrors.txt. This log contains a list of application errors that 
have been generated since the software was installed. Each error entry includes the date 
and time of the error, the error message, and the exception or call stack. Support personnel 
will also request this file.
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CHAPTER 4:

MAINTENANCE AND 
TROUBLESHOOTING

INTRODUCTION
  Note: Contact BFDF Technical Support before you access any internal components on the 
RAZOR® EX.

  Note: It is always a good idea to run the RAZOR EX with the battery installed, especially if 
poor power conditions are suspected.

  WARNING: Before you perform maintenance on the RAZOR EX, turn off the power, unplug the 
USB and power cables, and allow the instrument to cool. Wear safety glasses and protective gloves.

 CAUTION: Use caution when you remove sample pouches from the instrument; a tear in the 
bag could contaminate the instrument and the surrounding area. Carefully dispose of sample pouch-
es in a biohazard waste container.

The RAZOR EX is a field-hardened instrument designed for field use, but it is neither waterproof nor 
indestructible. With proper care and maintenance, the RAZOR EX will perform accurate and sensi-
tive PCR-based pathogen identification.

GENERAL MAINTENANCE
•	 As needed, wipe down the surface of the RAZOR EX and heater boards by using a cloth or 

paper towel and a 10% bleach solution (one part household chlorine bleach and nine parts 
water). Repeat process twice followed by two wipes with a cloth or paper towel dampened 
with water. Use this method to decontaminate the RAZOR EX instrument before returning it 
for service. See Appendix B for additional instrument return requirements.

CAUTION: Do not get bleach on the lenses or the battery contacts. Use lens cleaner 
and a lens cloth to clean the lenses.

•	 Periodically, use canned air to clean the sample chamber area between the internal heater 
plates by blowing it out. Be sure to wear eye protection and decontaminate the area first, if 
necessary (see “Lens and Heat Plate Cleaning”).

•	 Periodically, use an optical lens cleaner and a lens cloth to clean the lenses and heater 
plates (see “Lens and Heat Plate Cleaning”).

•	 Always wear gloves when you access and maintain internal parts.
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INSTRUMENT OVERVIEW
Use the following images to familiarize yourself with the RAZOR EX Instrument.

LCD Screen

Plunge Bracket

Pouch Slot

Power Key

Backlight Control

Back Key

Up Key

Select Key

Battery Pack (inserted)

Down Key

Serial Label

USB Port

Bar Code 
Reader

Power Port

Access Panel
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Heater 
Boards

Air Filter

Floating Side

Air Filter Removed
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PREVENTIVE MAINTENANCE
Each RAZOR EX Instrument comes complete with a tool kit that enables you to perform the tasks 
outlined in this manual. Use the image below to help you identify the necessary tools. If any tool 
becomes damaged or lost, contact BFDF Technical Support for a replacement.

Lens Cloth

Pliers

Air Filter

Lens Cleaning
Solution

ACCESSING INTERNAL COMPONENTS,  
HEATERS, AND LENSES

 WARNING: Before you access internal components of the RAZOR EX, turn off the power, 
remove the battery, and disconnect both the power cable and the USB cable. 

 WARNING: When you access internal components, keep the instrument in its upright position 
as shown in the images below. Also, be sure to use care to avoid damaging delicate components.

1.	 Locate the access panel side handles on the top sides of the RAZOR EX and carefully pull out-
ward on one side to remove the access panel. 

Access Panel
Side Handles

2.	 Carefully remove the other side of the access panel and place it to the side on a clean surface.
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3.	 Locate the heater board release levers located on the top and bottom on the back of the floating 
side heater board.

Heater board 
release levers 

 

4.	 Gently squeeze the levers together to unlock the heater board, then slide the board to the right 
about 1/2 in.

 

5.	 As the heater board slides, it will hit a stop. At this point, slide the whole board toward you until 
the levers hit the final stop.
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6.	 After you slide the board to the outside edge of the machine, pivot the right end of the board out, 
exposing the internal heater plates and lenses.

 

Lenses

Heater plate

7.	 To close the instrument when you are done working on it, follow steps 1 through 5 in reverse 
order.

 WARNING: Be sure that the internal heater board is closed and locked into place before you 
turn on the instrument.
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Lens and Heat Plate Cleaning

Type of Service: Preventive Maintenance/Corrective Maintenance

Recommended Frequency: Every 40 runs (about 20 hours of use), or after operation in an 
extreme environment such as a dust storm.

Possible Symptoms: Low fluorescence, spikes in real-time graph

Required Parts: None

Required Materials/Tools: Lens cloth (from the startup kit) or microfiber cloth, lens cleaning 
solution, canned air

 Caution:
Make sure gloves and cleaning cloth are clean before using on 
the lens. DO NOT POLISH IN A CIRCULAR MOTION. Dust par-
ticles can be ground into the lenses, decreasing the RAZOR EX’s 
ability to identify.

You should clean the lenses and heat plates periodically to ensure that the fluorescence acquisition 
is not impeded by dust that might accumulate on the surfaces. 

1.	 Follow the instructions on “Accessing Internal Components, Heater Bars, and Lenses” from the 
previous section.

2.	 After you have exposed the optic lenses and heaters, use canned air to clean the sample cham-
ber area between the internal heater plates by blowing it out. Be sure to wear eye protection and 
decontaminate the area first, if necessary.

3.	 Wet a lens cloth (supplied with the instrument), and/or a microfiber cloth that will not scratch the 
optic lenses, with the lens cleaning solution that has been supplied.

4.	 Drag the cloth across the lenses in a single direction.

5.	 Use a clean, wet area of the cloth by changing the position of your finger on the cloth and 
repeating the steps in this procedure as necessary.

6.	 After you have cleaned the lenses, clean the gold heater plates in the same way.
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Replacing the Air Filter

Type of Service: Preventive Maintenance/Corrective Maintenance

Recommended Frequency: Every 260 runs or 150 hours of use in normal environment. 
Every 125 runs or 75 hours in harsher environments (such as 
sand and blowing dust).

Possible Symptoms: Error codes:
V131 “Elevation, filter, leak, or sensor failed, POST.” OR
M130 “Pressure Timeout. Unable to Reach X PSI in bladder Y”

Required Parts: Air filter (RAZR-SUB-0406)

Required Materials/Tools: None

 Caution:
None

You should replace the air filter periodically to ensure that the instrument’s air system flows correctly. 
Make sure your hands are clean and that the environment is dust free. Allowing dust to get into the 
air system may damage the RAZOR EX. In turn, the damage can diminish the instrument’s ability to 
identify DNA targets. 

1.	 Remove the battery.

The air filter is a small clear cylinder that sits to the side of the battery in the compressor housing.

2.	 Pull the filter out with the connector hose. Notice the position of the tubing so that when you put 
the filter back, you will be able to put the tubing in the correct position. 

3.	 Gently pull the tubing off the installed filter fitment.
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4.	 Replace the filter with a new air filter (part no. RAZR-SUB-0406) that you have obtained from 
BFDF.  There are two valid configurations for the filter and tubing:

 WARNING: Make sure the arrow on the filter is pointing towards the intake tube. Insert the fil-
ter with the tubing into the instrument in its original position being careful not to kink or bend tubing. 
Replace only the filter unless the tubing is damaged.

a.	  If your RAZOR EX has approximately 4.5 in. of tubing between the filter and the housing, 
the filter is oriented with the inlet side facing the opening in the housing.

b.	 If your RAZOR EX has approximately 2 in. of tubing between the filter and the housing, the 
filter is oriented with the outlet side of the filter with the tubing connected facing the opening 
in the housing. The filter for this configuration also has two small holes drilled thru the inlet 
barb of the filter.

 WARNING: DO NOT Use the 2-in. tubing configuration unless you have a filter with the two 
holes drilled in the inlet barb of the filter. 
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Checking the Heaters
 
Type of Service: Corrective Maintenance

Recommended Frequency: After 40 runs (about 20 hours of use), or after any internal main-
tenance or shipping

Possible Symptoms: Error codes:
H128	 “Too cold or open sensor on Heater A.” OR
H129  	 “Too cold or open sensor on Heater B.” OR
H130 	 “Too cold or open sensor on Heater C.” OR
H131 	 “Too cold or open sensor on Heater D.”

Required Parts: None

Required Materials/Tools: None

 Caution:
Be sure that you disconnect the RAZOR EX from an external 
power supply and battery before you attempt this procedure.

1.	 Follow the instructions on “Accessing Internal Components, Heaters, and Lenses” found in this 
chapter.

2.	 Check the heater plugs leading into the RAZOR EX internal electronics. 

There are two sets of red-wired plugs and two sets of yellow-wired plugs. Gently press the wire 
harnesses into the base plugs to ensure that they are seated correctly. 

 

3.	 Check the heater plugs that lead into the back of the two heater boards. 
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4.	 Check the heater plugs leading into the front two heater boards.

5.	 Reassemble and close instrument.

6.	 Reconnect power and power on the instrument allowing it to run its power-on self-test (POST). If 
errors persist, contact BFDF’s Technical Support.
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Battery Contact Cleaning
 
Type of Service: Corrective Maintenance

Recommended Frequency: Every 100 hours of battery use

Possible Symptoms: Intermittent power supplied from battery pack. 
Battery not reaching full charge.
Error codes:
M002 “Low Battery” (Warning) OR
M138 “Battery Too Low”

Required Parts: RAZOR EX Battery Pack

Required Materials/Tools: Pencil Eraser

 Caution:
Do not change a battery while the machine is running unless the 
instrument is plugged in. If you have to change a battery mid-
run, first plug in the external power supply to the external port. If 
you don’t, you will lose the run data and you will not be able to 
recover it.

Do not incinerate battery pack. Do not expose to high tem-
peratures (140 ºF / 60 ºC). Do not disassemble.

1.	 Place the RAZOR EX battery pack on a flat surface such as a table or workbench. The gold 
colored battery contacts should be facing up as shown. Look for discoloration, such as black 
streaks on the battery contacts. 

Battery contacts

 

2.	 Using a standard pencil eraser, lightly rub each contact until you remove the streaks. DO NOT 
rub the contact with a ‘back and forth’ motion. Rub in only one direction. On the underside of the 
RAZOR EX instrument and on the RAZOR EX battery charger, the contacts are spring loaded, 
and you must take care to rub from the spring attachment point outward. When you are done, 
the contacts should be free from dark discoloration.
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You can follow the same procedure on the contacts that are located on the underside of the 
RAZOR EX Instrument and on the contacts that are located on the RAZOR EX battery charger.

 

Battery contacts
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Battery Charging
 
Type of Service: Corrective Maintenance

Recommended Frequency: Every 3–4 hours of instrument use on battery power

Possible Symptoms: The RAZOR EX instrument will not power up on battery power, 
but it does power up on external power.  
Error codes: 
M002 “Low Battery” OR
M138 “Battery Too Low”

Required Parts: RAZOR EX Battery Charger and External Power Supply 
RAZOR EX Battery Pack

Required Materials/Tools: N/A

 Caution:
Do not change a battery while the machine is running unless the 
instrument is plugged in. If you have to change a battery mid-
run, first plug in the external power supply to the external port. If 
you don’t, you will lose the run data and you will not be able to 
recover it.

Do not incinerate battery pack. Do not expose to high tem-
peratures (140 ºF / 60 ºC). Do not disassemble.

1.	 To turn off the instrument, select Main Menu > Shut Down.

 

2.	 When the RAZOR EX has turned off, remove the battery by pulling down the pin and sliding the 
battery off the bottom of the instrument.

 

 

3.	 Using the directional arrows on the side of the battery and charger as a guide, line up the battery 
and the charger. Slide the battery onto the charger until the green light blinks. 
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4.	 Plug the power supply into a grounded AC power source and connect the other end to the 
recharger. When you have plugged in the recharger, the red light will come on.

 Note: Ensure that the vent on the charger is not obstructed while the charger is running.
 

 

5.	 In addition to the red light, the green light also comes on when the battery begins to charge. The 
green light will blink four times then pause, then repeat while the battery is charging. As the bat-
tery charges, the number of blinks decreases (4, 3, 2, 1) and then becomes solid once the bat-
tery charge is full. 

 Note: A fully depleted battery takes approximately 8 hours to fully charge. 
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Bar Code Reader Window Cleaning
 
Type of Service: Preventive Maintenance/Corrective Maintenance

Recommended Frequency: Every 15 hours of use, or after operation in an extreme environ-
ment such as a dust storm.

Possible Symptoms: Difficulty reading bar code data into the instrument. It might take 
longer than usual, or it might not read at all.

Required Parts: None.

Required Materials/Tools: Lens cloth (from the startup kit) or microfiber cloth

 Caution:
DO NOT POLISH IN A CIRCULAR MOTION (you will grind any 
particles picked up by cloth into the window).

You should clean the rear protective window for the bar code reader periodically to ensure that the 
data acquisition is not impeded by dust that might accumulate on the surfaces. You should be very 
careful, because if you scratch the window by cleaning it incorrectly, you will diminish the ability of 
the RAZOR EX to read protocol bar codes. Wear gloves when you clean the lens.
1.	 Remove the rubber protective cover to access the bar-code reader window on the lower-left cor-

ner of the instrument window’s rear panel. Use a lens cloth (supplied with the instrument) and/
or a microfiber cloth that will not scratch the optic lenses. Wet the cloth with the cleaning solution 
that has been supplied.

2.	 Drag the cloth across the lens in a single direction.

 

 

3.	 Use a clean area of the cloth by changing the position of your finger on the cloth and repeat 
steps.

4.	 Once you have cleaned the lens, replace the rubber protective cover. This cover should be in 
place at all times (when the reader is not in use) to ensure that the window stays as clean as 
possible.
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ERROR CODE TROUBLESHOOTING

The RAZOR EX is enabled with self-diagnostics that run continuously while you operate the instru-
ment. The self-diagnostics can generate two types of errors: fatal errors and warnings. 

•	 Fatal errors are problems diagnosed within the instrument that are beyond the operating tol-
erances of the system. These errors will not allow the instrument to run correctly and require 
that you turn off the instrument. Error resolution requires that you set the system in its nor-
mal configuration and either restart it or return it for repair.

•	 Warnings are problems diagnosed within the instrument that fall within operating tolerances. 
The RAZOR EX can compensate for these errors in most cases and run within its operating 
tolerances. Resolution of some of these errors can be done onsite, while others require that 
you return the instrument for repair. Contact BFDF Technical Support to help resolve these 
problems.

You should note all error messages before you call BFDF for technical service. A complete list of 
error messages will help the people in technical service resolve the instrument error. 
An error can occur in a number of the instrument’s subsystems: the fluorimeter, the heater, and the 
master or valve controllers. The error format is a code indicating the source of the error (F, H, M, or 
V) followed by three numbers corresponding to the type of error and a message to the user. 

 Note: for any errors not listed below, contact BFDF Technical Support. 

See the chart below for error codes: 
Xnnn error message 

time stamp

Code Description of Code

F The fluorimeter controller detected the error

H The heater controller detected the error

M The master controller detected the error

V The valve controller detected the error

P The power controller detected the error

nnn A three-digit error number specifying the type of error

The “error message” is specific to the type of error.

The instrument logs all errors and warnings under Utilities\View Logs\Error Log so that they are 
always available for display through the utilities function.
The POST is an internal diagnostic routine the instrument runs every time you turn on the instrument 
power. When fatal errors occur during POST, normal operation cannot continue. When a warning 
situation occurs during POST, the software displays a message but continues normal operation.

 Note: The POST may fail if a pouch is present or if the instrument is open when you turn on 
the machine. If an error occurs during POST, confirm that the pouch from the previous run has 
been removed and that the heater bars and access panel are in place. Shut down the instrument 
and then restart it.



< 84 > RAZOR® EX < > Operator’s Manual 

Chapter 4: Maintenance and Troubleshooting

If a warning occurs during normal operation, the instrument continues until it is powered down. When 
it is powered back on, the software displays the contents of the log before proceeding to normal 
operation. When there is a fatal error during operation, the machine shuts down.
If there is a battery charger error, both LED’s will blink. Confirm that the external power source is the 
cable and converter provided with the RAZOR EX instrument. If it is, and blinking continues, then con-
tact BFDF Technical Support. 

H128	 “Too cold or open sensor on Heater A.” OR
H129  	 “Too cold or open sensor on Heater B.” OR
H130 	 “Too cold or open sensor on Heater C.” OR
H131 	 “Too cold or open sensor on Heater D.”

1.	 Warm the instrument until it is above 0°C.
2.	 Confirm that the heaters are connected. (See “Checking the Heaters” in this chapter.)
3.	 Restart the instrument.
4.	 If the error recurs, contact BFDF Technical Support. 

H136 “RAZOR too cold to run.” 
1.	 Warm the instrument until it is above 0°C.
2.	 Restart the instrument.
3.	 If the error recurs, contact BFDF Technical Support. 

H137 “RAZOR too hot to run.”
1.	 Cool the instrument until it is below 40°C.
2.	 Restart the instrument.
3.	 If the error recurs, contact BFDF Technical Support.

M128 “Unable to Shutdown”
1.	 Disconnect the external power supply and battery.
2.	 Reconnect the external power supply or battery.
3.	 Restart the instrument.
4.	 If the error recurs, contact BFDF Technical Support.

M130 “Pressure Timeout. Unable to Reach X PSI in bladder Y”
1.	 Check the air filter and replace it if necessary. (See “Replacing the Air Filter” in this 

chapter.)
2.	 If the error recurs, contact BFDF Technical Support.

 Note: Removing the battery during a run will cause the machine to shut down unless you 
have also connected an external power supply. Similarly, removing the external power supply dur-
ing a run will cause the machine to shut down unless you have also connected a charged battery.  

M138 “Battery Too Low”

1.	 Connect the external power supply (if it is running) or a new, charged battery.
2.	 Charge the battery before replacing it onto the instrument. (See “Battery Charging” in this 

chapter.)
3.	 If the battery was fully charged, see “Battery Contact Cleaning” in this chapter.
4.	 If the error recurs, contact BFDF Technical Support.

M003 “Low External Power” (Warning) OR

M139 “External Power Too Low” OR

M141 “External Power Too High”

1.	 Use only an BFDF-provided power supply.
2.	 If the error recurs, contact BFDF Technical Support.
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V131 “Elevation, filter, leak, or sensor failed, POST.” 

1.	 Remove air filter from housing.
2.	 Check the air filter and replace it if necessary. (See “Replacing the Air Filter” in this 

chapter.)
3.	 Check tubing and replace if kinked or damaged.
4.	 If the error recurs, remove battery, straighten filter tubing, and reboot instrument. Run 

instrument with filter out. 

5.	 If the error continues to recur, contact BFDF Technical Support.

V148 “Valve(s) too slow, POST.” OR

V154 “Unable to heat manifold, POST.”

1.	 Warm the instrument until it is above 0°C.
2.	 Restart the instrument.
If the error recurs, contact BFDF Technical Support. 
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PCR TROUBLESHOOTING
This section contains examples of normal and abnormal PCR data. For the abnormal PCR data, 
this section also contains possible causes and resolutions. For more details, see the RAZOR Pouch 
Instruction Booklet.

Normal PCR Data

Abnormal PCR Data
(no amplification of positive controls)

Abnormal Spikes or Noise in 
Fluorescence Curves (caused by air 
bubbles introduced into the pouch 

during loading) 
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Error Cause Solution
No pouch in the RAZOR EX. Check to make sure that the pouch was in the 

RAZOR EX during the run.

The liquid was not plunged into the sample slot 
of the pouch.

Check the plungers to make sure that they are 
pressed down all the way.

The pouch was placed incorrectly in the 
machine so that sample slots were not directly 
over the fluorimeters.

Make sure that the fitment in the pouch sits 
perfectly in the groove over the insert slot in the 
machine.

Expired reagents. Check the pouch expiration date. If the date has 
expired, repeat the run with a new pouch.

Bad reagents. Did the pellets look white and fill the wells? 
If a pouch issue is suspected, contact BFDF 
Customer Support.

Amplification inhibition/inhibition control fails. Make sure that the water and the sample used 
to resuspend reagents are clean and free of 
amplification inhibitors. Repeat the run with 1:10 
dilution of sample.

Plungers not twisted. Check that the plungers were twisted so that 
the arrows point to the middle (parallel with the 
fitment) before plunging.

Sample not added. Confirm that liquid was pulled out of the syringe 
into the pouch fitment.

USB connection lost with intermittent or poorly 
regulated power.

Reset USB port by either resetting port on the 
PC or unplugging then replugging the USB 
cable.

Bar code reader quits after electrostatic 
discharge to RAZOR case.

Reboot RAZOR EX.

If intermittent or poorly regulated power 
conditions are suspected, run the instrument 
with the battery pack installed.

Positive control fails. Use only sample and control buffers included in 
the RAZOR EX pouch kit.



< 88 > RAZOR® EX < > Operator’s Manual 

Chapter 4: Maintenance and Troubleshooting

Causes for Abnormal Fluorescence Curves Solution
A loss of vacuum allowed air into the channel. If the pouch did not pull liquid from the syringe 

into the channel while it was loading, or if it 
pulled very little liquid, contact BFDF Customer 
Support.

Air in the syringe allowed air into the channel. Make sure the syringe is full of liquid with no air 
bubbles before you load it. 

The syringe does not have enough liquid. Before you load the pouch, ensure that the 
syringe has at least:
•	 0.5 mL of liquid per port in a 4 x 3 100 µL 

pouch
•	 0.2 mL per port in a 12 x 1 100 µL pouch 
•	 0.35 mL per port in a 6 x 2 100 µL pouch
•	 2.0 mL per sample port for 1 x 12, 11 + 1, 

and 10 + 2 100 µL pouches; .4 mL for control 
port

DECONTAMINATION AND CLEANING  
PROCEDURES

 Note: The procedures in this section describe 3 bleach wipes and 3 distilled water wipes 
for general maintenance decontamination and for returning an instrument. If you have a 
spill or pouch breakage, BFDF recommends 10 bleach wipes and 10 distilled water wipes 
to ensure complete amplicon eradication. If the instrument has been used with pathogenic 
agents, gas decontamination may be required. Contact BFDF Technical Support.

If a spill occurs, the decontamination and cleaning procedures in this section are intended to limit 
the spread of DNA or RNA, PCR amplicon, or biohazards. You have to decontaminate all areas that 
might have been contaminated to prevent false-positive readings in subsequent runs. For instance, if 
a spill occurs in the RAZOR EX reaction chamber, decontaminate the RAZOR EX instrument and the 
bench top (or other area) surrounding the RAZOR EX. 

 Warning: Do not wipe bleach on the optics or battery contacts.

After a spill, change gloves and other potentially contaminated personal protective equipment. 
Change gloves often during the decontamination process, especially during the first steps of decon-
tamination and before touching any clean surface. Dispose of all personal protective equipment after 
the decontamination.
This list provides items that are necessary in a laboratory to keep contamination to a minimum.

•	 10% bleach solution in a squeeze or spray bottle (1 part bleach to 9 parts water)

•	 Distilled water in a squeeze or spray bottle

•	 95% ethanol in a squeeze bottle

•	 DNAZap™, or an equivalent DNA degrading system

•	 Paper towels



< 89 >RAZOR® EX < > Operator’s Manual

Chapter 4: Maintenance and Troubleshooting

•	 Bleach wipes

•	 Lens cleaner

•	 Lens cloth

RAZOR EX Internal Instrument Decontamination
 Note: Decontaminate the interior of the RAZOR EX instrument before decontaminating the out-

side.

1.	 Put on gloves. Open the heater boards. (See “Accessing Heater Bars and Optic Lenses” in this 
chapter for detailed instructions.)

2.	 Wet the lens cloth with the 10% bleach solution.

3.	 Gently wipe the following items. When you are cleaning the heater board, wipe around, but not 
across, the optic lenses; be very careful not to scratch the lenses.

•	 The heater board

•	 The bottom of the heater chamber

•	 The inside of the access panel

4.	 Repeat step 3 twice changing gloves each time.

5.	 Change gloves. Wet a fresh lens cloth with distilled water and repeat step 3 three times chang-
ing gloves each time.  

RAZOR EX External Instrument Decontamination
1.	 Put on gloves. Wet a paper towel with the 10% bleach solution and wipe the entire exterior of 

the instrument, including the bottom and the bench top where the instrument had contact and 
the battery. Avoid the battery contacts, just as you avoided the optic lenses.

2.	 Repeat step 1 twice, with fresh paper towels and clean gloves, for a total of three bleach wipes.  

3.	 Change gloves, then wet a new paper towel with distilled water and repeat step 1 using the 
water wipe.

4.	 Repeat step 3 twice with distilled water for a total of three wipes.  

Decontamination of Bench Tops and Other Areas
1.	 Spray the 10% bleach solution on the area that may have been contaminated. Let it stand for 5 min.

2.	 Wipe the area with a clean paper towel, and then change gloves.

3.	 Repeat steps 1 and 2 twice, for a total of three wipes.

4.	 Change gloves and spray the area with distilled water.

5.	 Wipe the area dry with a new paper towel. Change gloves.

6.	 Spray the area with DNAZap, or an equivalent product. Follow the product’s instructions for cor-
rect use. Change gloves.

7.	 Rinse the area by spraying it with distilled water and wiping it dry. 
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Maintenance Log
A decontamination and cleaning record should be kept on a log similar to the one shown.
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APPENDIX A:

FLUORIMETRIC REAL-
TIME DETECTION  
PRINCIPLES

COMPONENTS OF POLYMERASE CHAIN  
REACTION
Polymerase chain reaction (PCR) is the process of making billions of copies of nucleic acid. This 
process involves separating the double-stranded deoxyribose nucleic acid (DNA) into separate 
strands and making multiple copies of each strand. A large quantity of DNA is needed for detectable 
and recordable fluorescence. 

To copy DNA, four components are needed: 

1.	 DNA polymerase

2.	 A supply of the four nucleotide bases—deoxyribonucleotide triphosphate or dNTPs

3.	 Primers 

4.	 Target DNA

The DNA polymerases, whether from humans, bacteria, or viruses, cannot copy a chain of DNA 
without a short sequence of nucleotides to “prime” the process, commonly called a primer. Once the 
primer anneals, DNA polymerase can take over making the rest of the new chain. 

Real-time PCR is a complex mixture of sample DNA, primers, probes, dNTP molecules, DNA poly-
merase enzyme, and buffer. The PCR reaction is incorporated with either nonspecific DNA binding 
dyes or a fluorescent-based probe system to monitor the amplification of DNA during the tempera-
ture cycling.
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Sample DNA

•	 Provides the target template

Primers
Approximately 25 bases long (nucleotides adenine (A), thymine (T), cytosine (C), and guanine (G), 

which act as the building blocks and backbone of DNA).
Define each end of the sequence of DNA to be amplified.
Complementary to a specific region of interest.
Anneal to denatured (separated) DNA template.
Docking station for polymerase.
Excess amounts in master mix ensures the primer will bind to the complementary sequence of inter-

est.

Probes 
Approximately 25 bases long (nucleotides adenine (A), thymine (T), cytosine (C), and guanine (G), 

which act as the building blocks and backbone of DNA).
Specific to target DNA and have fluorescent dyes attached to their sequences.
Types of probes

Hybridization probes have one red probe and one green probe that are designed to hybridize 
together and then fluoresce.

Hydrolysis probes have one green probe that is cut and then fluoresces.
•	 Fluorescence is proximity dependent.
•	 When bound, instrument LED excites the green dye, which then excites the red dye leading to 

measurable fluorescence.
•	 Fluorescence proportional to PCR (number of copies of the target sequence).

dNTPs—Deoxynucleotide Triphosphates 
Needed for DNA synthesis.
dNTPs have a nucleotide and an energy donor.
Nucleotide bases are the actual building blocks used to create the copied DNA strand. 
Bind in pairs: A and T, C and G.
Equal amounts of nucleotides are used to prevent mismatches of bases.
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Defines amplicon (targeted area of DNA).

Enzyme 

Polymerase enzyme builds the DNA copy by placing each nucleotide base in its proper position.
Stable at very high temperatures >100 °C.
Must have a template strand of DNA to copy. 

Buffer
Maintains the optimal reaction pH (a measure of the strength of acids and bases) for PCR.
Contains stabilizing ions.
Polymerase requires free ions for activity.

Water
•	 The universal solvent and standard diluent
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POLYMERASE CHAIN REACTION BASICS
 
The three parts of PCR are carried out in the same slot, but at different temperatures. Each PCR 
cycle is comprised of three processes: denaturation, primer annealing, and primer extension. First, 
the DNA is heated to achieve denaturation. The primers cannot bind at a high temperature, so the 
DNA is then cooled, which allows the primers to anneal and extend. The PCR reaction therefore 
involves temperature cycling, and the DNA polymerase used in the reaction must be tolerant of high 
temperatures and rapid heating and cooling. 

Room
Temperature
25˚C / 77˚F

91˚C / 201˚F 

60˚C / 140˚F 

60˚C / 140˚F 
Primer

Primer

Primer

Primer

Enzyme

Enzyme dNTP

dNTP

Room
Temperature
25˚C / 77˚F

DNA at room temperature in a normal environment is double stranded

Step 1. Denaturation  
A sample containing double-stranded DNA target strands is heated to about 91ºC (about 196ºF). 
This process separates the DNA strands.

Step 2. Annealing 
The sample is cooled to about 60ºC (about 140ºF), which allows the primers to bind or “anneal” 
to the DNA strands at a specific sequence. Sequence, composition of nucleotides, and length of 
primers determine optimal annealing temperatures.

Room
Temperature
25˚C / 77˚F

91˚C / 201˚F 

60˚C / 140˚F 

60˚C / 140˚F 
Primer

Primer

Primer

Primer

Enzyme

Enzyme dNTP

dNTP

Room
Temperature
25˚C / 77˚F

Step 3. Extension
The final step of the reaction is to make a complete copy of the templates. The sample is held at the 
anneal temperature to allow the nucleotides to fill in and read the fluorescence of the probes. At tem-
peratures close to the annealing temperatures, the enzyme is effective and efficient. 
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Room
Temperature
25˚C / 77˚F

91˚C / 201˚F 

60˚C / 140˚F 

60˚C / 140˚F 
Primer

Primer

Primer

Primer

Enzyme

Enzyme dNTP

dNTP

Room
Temperature
25˚C / 77˚F

The DNA polymerase begins adding nucleotides to the primer and eventually makes a complemen-
tary copy of the template. If the template contains an A nucleotide, the enzyme adds on a T nucleo-
tide complementary to the target strand. If the template contains a G, it adds a C to the new chain, 
and so on until it reads to the end of the DNA strand. This completes one PCR cycle. 

Room
Temperature
25˚C / 77˚F

91˚C / 201˚F 

60˚C / 140˚F 

60˚C / 140˚F 
Primer

Primer

Primer

Primer

Enzyme

Enzyme dNTP

dNTP

Room
Temperature
25˚C / 77˚F

The three steps in PCR—denaturation, annealing, and extension—take less than 2 min. Each is 
carried out in the same sample slot. At the end of a single cycle, each piece of DNA has been 
duplicated. A typical PCR program will run a total of 45–55 cycles. 

Each newly synthesized double-stranded DNA copy acts as a new template, so after 30 cycles, 
1 billion copies of a single piece of DNA can be produced! Taking into account the time it takes to 
change the temperature of the sample pouch, 1 billion copies can be created in less than 30 min. 

REVERSE TRANSCRIPTION

Some microbes have RNA as the genetic material. Some assays therefore target cellular RNA 
molecules. When RNA is the starting material, reverse transcription must be done before perform-
ing PCR. Reverse transcription converts RNA to amplifiable DNA. This process involves using an 
enzyme called reverse transcriptase, which builds a DNA strand from the RNA strand (a T for thy-
mine is substituted for the U of uracil in RNA). Once the DNA strand is built, it is then amplified as 
described in the previous section.



< 96 > RAZOR® EX < > Operator’s Manual 

Appendix A: Fluorimetric Real-time Detection Principles

ANALYSIS METHODS
 
Agarose Gel Electrophoresis
Electrophoresis is a technique used in the laboratory that results in the separation of charged mol-
ecules. The DNA molecule is negatively charged and moves by electric current through a matrix of 
agarose.

Once the PCR cycle is complete, the user needs a tool to view the duplicated product. One conven-
tional method is an agarose gel viewed under an ultraviolet (UV) lamp. 

Size Marker

1000 bp
750 bp
500 bp
400 bp
300 bp

Product

Fluorimetric Detection Real-time Polymerase Chain Reaction
In real-time PCR, a short specific DNA sequence called a probe is used to measure DNA amplifica-
tion. Probes have fluorescent dyes attached to their sequences, which enables a user to measure 
DNA quantity. Two types of probe methods are described in the following sections.
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Hybridization Probes
Hybridization probes are composed of a pair of DNA strands designed to hybridize adjacent to each 
other. Each carries a dye (fluorophore) at its facing end, which interact. The shorter green wave dye, 
fluorescein, is excited by blue light from the instrument’s LED and transfers its energy to the longer 
red wave dye, LCRed 640. This fluorophore emits red light, which is detected by the instrument. 
Therefore, the signal will only activate when both probes bind adjacent to each other. This transfer 
of energy is called fluorescence resonance energy transfer, or FRET. The fluorescent signal will be 
proportional to the number of copies of the target sequence.
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Hydrolysis Probes
A hydrolysis probe (often sold under the tradename TaqMan®) provides a quantitative signal of ampli-
fied samples. The shortcoming of this technique is that it doesn't provide a melt profile for subse-
quent analysis, because the probe is destroyed during the PCR process. 

The probe consists of a DNA strand of approximately 20–30 bases with a quencher dye at one end 
and a reporter (fluorescent) dye at the other end. Light from the instrument's LED stimulates the 
reporter dye to emit a signal, which is absorbed by the quencher. After the probe hybridizes with the 
target DNA strand and the Taq enzyme hydrolyzes (decomposes) the probe, the quencher is sepa-
rated from the reporter (along with the synthetic DNA bases), and the excited reporter fluoresces. A 
detectable signal occurs only when the probe is hydrolyzed by the Taq enzyme. As DNA is amplified, 
this process repeats, increasing the fluorescent signal of the sample. 
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Understanding Sample Crossing Points
In an amplification reaction, the cycle at which the fluorescence of a sample rises above the thresh-
old level of background fluorescence is called the crossing point (Cp) of the sample. The presence of 
a Cp indicates that target DNA is present. A Cp is the point at which amplified product is first visible 
in the data. The Cp is given to determine the amount of fluorescent PCR product present. The soft-
ware uses the second derivative maximum of each data curve (where the slope of the curve chang-
es) to extrapolate the point where the threshold is crossed. A sample’s Cp is expressed as a cycle 
number. An earlier Cp indicates the presence of more starting target DNA than a later Cp. The PCR 
process is exponential; it approximately doubles every cycle. Consequently, a 10-fold dilution should 
be approximately 3.5 PCR cycles later than an undiluted sample. A sample with a lower initial con-
centration of target DNA has a higher Cp because it requires more amplification cycles to reach the 
threshold. A sample with a higher concentration of DNA generally has an earlier, lower Cp because it 
requires fewer cycles to reach that threshold.

Crossing point

Understanding Max Fluorescence
Fluorescence increases as more PCR product is made. Max fluorescence measures the highest 
level of fluorescence reached by a sample during the PCR run. The fluorescence has the initial back-
ground fluorescence subtracted, thus providing a baseline to compare different samples. 

If a large amount of template is initially present, the fluorescence may plateau near the end of the 
run. This is most likely due to the necessary components for PCR being consumed by the reaction.
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APPENDIX B: 
U.S. DECONTAMINATION 
AND RETURN FORMS

 Note: For international returns, please call Technical Support for detailed instructions.

An instrument problem may be reported by calling, e-mailing, or mailing BioFire Defense. The con-
tact numbers are located below.

If you are returning an instrument for repair, follow the basic guidelines prescribed in this appendix. 
You will also need the following documents:

	 Declaration of Decontamination 
	 Decontamination Labels 
                                                                                                                   
These forms and instructions can also be downloaded from: 
	 http://biofiredefense.com/product-support

Phone
	 (801) 262-3595 - United States and Canada 
	 +1-801-262-3595 - International

E-mail
	 support@BioFireDefense.com - Technical Support

Web Site
	 http://biofiredefense.com/product-support

Address
	 BioFire Defense
	 79 West 4500 South, Suite 15
	 Salt Lake City, UT 84107
	 USA
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Step 1: Obtain a Return Materials Authorization Number
The first step in returning an instrument to BFDF is to obtain a Return Materials Authorization (RMA) 
number from our Service Department by filling out the RMA form at  
https://www.biofiredefense.com/product-support/return-forms/. 

A Technical Service specialist will contact you with an RMA number and further instructions. If your 
instrument is still under warranty, please supply the purchase date and serial number, if your instru-
ment is out of warranty, please supply a blank PO# for the repair charges.

Step 2: Decontaminate All Returned Equipment
You must decontaminate all equipment being returned to remove amplicon contamination and to 
ensure that personnel handling the equipment are not harmed by pathogenic organisms. 

The person responsible for the return must thoroughly decontaminate the unit by following the 
instructions in “Decontamination and Cleaning Procedures,” in Chapter 4, Maintenance and 
Troubleshooting. 

Biological Lab Decontamination
The person responsible for the return must thoroughly survey the instrument for contamination and 
ensure its compliance to regulations. If the instrument has been used with live agents, a licensed 
person must complete the necessary forms and follow standard procedures by law.  

Step 3: Decontamination Labels
After the above steps have been completed, the person responsible for the return must complete 
and sign two decontamination labels and attach one to the instrument and the other to the exterior 
of the shipping container. Complete and sign the Declaration of Decontamination form; a photocopy 
should be made for your records and the original must be returned with the instrument.

 Note: An RMA number must be obtained from BFDF before shipping. The RMA number and 
decontamination labels must be visible on the exterior of the shipping container.

BFDF reserves the right to return or refuse receipt of any materials at the customer’s expense that 
do not meet these requirements.

Step 4: Packaging and Shipping
1.	 Package the RAZOR EX instrument inside its Pelican case and put it into a large heavy-weight 

box (recommended box size 24" x 19" x 23" or larger). Pack all sides with 2 inches of instant 
packing foam or packaging material.

3.	 Pack all accessory components in packing materials and place in packing box.
4.	 Fill all sides and top of the shipping box with at least 2 inches of instant packing foam or pack-

aging material to protect against shipping damage. 
5.	 Seal the box with packaging tape. 
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Battery Pack Shipping Instructions
6.	 If you are returning the battery pack with the RAZOR EX instrument, you will need to label your 

need to label your return shipping package with the appropriate hazardous 
materials label.  Also consult with your shipping carrier for the latest ship-
ping regulations https://www.ups.com/content/us/en/resources/ship/pack-
aging/guidelines/batteries.html?WT.mc_id=VAN701573

Return Instrument Check-off List
To avoid complications with the return of an instrument, please check off each box before returning 
the instrument to BioFire Defense. All items on this list should be included when returning an instru-
ment.

r	Did you get an RMA number from BioFire Defense?
r	Did you complete the decontamination procedures?
r	Did you attach the decontamination labels to the outside of the box and on the instrument?
r	Did you include all of the startup kit and accessory kit items with the instrument? (For loaner or 

replacement only.)

The following parts should be included with the returned instrument.

r	RAZOR EX instrument
r	Battery
r	Battery charger
r	Power cords
r	USB cable

Please check appropriate box if parts below are included with the returned instrument:

r	Operator manual 
r	Quick guides 
r	Software CD
r	Needle nose pliers
r	Air filter (spare)
r	Lens cleaning solution
r	Lens cleaning tissues
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Declaration of Decontamination

This instrument has been decontaminated according to established BioFire Defense biological 
decontamination procedures (found in Chapter 4).

Which method was used? __________________________________________________________

_ ______________________________________________________________________________

_ ______________________________________________________________________________

What chemical, infectious, toxic, or radioactive substances have been in contact with this product? 
(Also indicate if flammable or corrosive.)_______________________________________________

_ ______________________________________________________________________________

_ ______________________________________________________________________________

Authorization Notice

By accepting this authorization to return this product, the user assumes all responsibility for decon-
tamination and cleaning. BioFire Defense reserves the right to refuse the delivery of products that 
do not appear to have been properly decontaminated. If the equipment was used with or around 
radioactive material, the signature of the safety officer is also required.

Signature:________________________________ Date:___________________________________

 Declaration of Decontamination
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Decontamination Labels
Please complete these decontamination labels and affix one to the instrument case and the other to 
the exterior of the shipping carton. Failure to decontaminate before shipping to BioFire Defense will 
result in the immediate return of the unit at your expense.

Copy and cut out the label and attach it to the case of the instrument being returned.

DECONTAMINATION NOTICE:
This product has been decontaminated per Return Equipment policy: ________

BioFire Defense Return Authorization (RMA#):___________________________

Customer Name:_ _________________________________________________

Customer Address:_________________________________________________

________________________________________________________________

Signature: _____________________________________ Date:  ____/___/____

Copy and cut out the label and attach it to shipping container of the instrument being returned.

DECONTAMINATION NOTICE:
This product has been decontaminated per Return Equipment policy: ________

BioFire Defense Return Authorization (RMA#):___________________________

Customer Name:_ _________________________________________________

Customer Address:_________________________________________________

________________________________________________________________

Signature: _____________________________________ Date:  ____/___/____
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APPENDIX C:

QUICK GUIDES FOR THE 
RAZOR EX INSTRUMENT

INTRODUCTION
This appendix contains the quick guide for the RAZOR EX Instrument. This guide has been devel-
oped as an abbreviated version of certain tasks that are repeated often and is provided as a guide 
for a trained operator. For a more detailed description of the items contained in this guide, refer to 
the specific sections in this manual.

This Quick Guide describes the following procedures:
•	 Setting up the RAZOR EX Instrument
•	 Recharging the battery
•	 Scanning the protocol bar codes
•	 Loading the RAZOR EX pouch
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Setting Up the RAZOR® EX Instrument
1.	 Unpack the RAZOR EX instrument and set it on a solid, flat surface.  

2.	 Slide the battery into the bottom-right side of the instrument using the 
directional arrows on the side of the battery as a guide. You may need 
to collapse the instrument stand. Be sure the locking pin slides into 
place. Install the battery even if using the power supply.

3.	 If using external power, plug the power supply into a grounded power 
source and connect the other end to the RAZOR EX power port by lin-
ing up the red dots.

4.	 Open the protective lid. 

5.	 Press and hold the Power button for 5 sec. The screen will display the 
instrument’s current status. 

6.	 The instrument will next perform a 40-sec. self-diagnostics test. If you 
get an error message, refer to “Error Code Troubleshooting” in Chapter 
4 of the operator’s manual.

7.	 Press the Brightness button to adjust display lighting.

Recharging the Battery
1.	 Turn the instrument off.

2.	 Pull the ring on the battery down and slide the battery out.

3.	 Slide the battery onto the recharger until it clicks.

4.	 Plug the power supply into a grounded AC power source and con-
nect the other end to the recharger. 

5.	 When the battery is charging, the green light will blink. When the 
battery charge is full, the green light will be solid.

Scanning the Protocol Bar Code
 Note: Protocol bar codes can be scanned before field deployment. Be sure that all bar codes are as smooth 

and flat as possible.

 Note: Hold the bar code approximately 6–8 in. from the back of instru-
ment and center the bright green aiming beam over the bar code in any 
direction (vertically, horizontally, diagonally). When the scan completes, the 
aiming beam will disappear and the instrument will display the message, 
“Loading Barcode Data.” If the scan does not complete within 15 sec., flatten 
the image and/or move the bar code gradually closer to the instrument while 
you are scanning it.
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1.	 Select Main Menu > Utilities.
2.	 Select Scan Protocol Code.

3.	 Scan the square protocol bar code on the kit box by holding it up to the scanner at the back of the 
RAZOR EX.

Bar Code 
Reader

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: GENERICB
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0
0
1
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 0

1

Consult the instrument manual or pouch
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Scanning the Pouch Bar Code
1.	 Select Run Pouch from the Main Menu. When Scan POUCH Barcode displays, scan the rectangular 

bar code on the pouch (bar code must be held vertically). After the scan, the screen will display Loading 
Barcode Data.

		

 Note: If the bar code does not scan properly, the message “Aborting Barcode Scan,” will display. If 
you scan the wrong bar code, the message “Invalid Barcode Data (Barcode Should Be Rectangular)” will 
appear.

GENERICB-GENB0001 GENERICB-GENB0002 GENERICB-GENB0003

GENERICB-GENB0004 GENERICB-GENB0005 GENERICB-GENB0006

GENERICB-GENB0007 GENERICB-GENB0008 GENERICB-GENB0009

GENERICB-GENB0010 GENERICB-GENB0011 GENERICB-GENB0012

GENERICB-GENB0013 GENERICB-GENB0014 GENERICB-GENB0015

GENERICB-GENB0016 GENERICB-GENB0017 GENERICB-GENB0018

GENERICB-GENB0019 GENERICB-GENB0020 GENERICB-GENB0021

GENERICB-GENB0022 GENERICB-GENB0023 GENERICB-GENB0024

GENERICB-GENB0025 GENERICB-GENB0026 GENERICB-GENB0027

GENERICB-GENB0028 GENERICB-GENB0029 GENERICB-GENB0030
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Sampling
Dry Sample (Powders, etc.)

1.	 Touch the dry swab to the unknown powder.
2.	 Place the swab into the appropriately labeled vial and break off at break point.
3.	 Secure the cap on the vial and shake vigorously for 30 sec.

Liquid Sample (Automatic air samplers, etc.)
1.	 Transfer approximately 0.5 mL of liquid to the appropriately labeled vial.
	 - To draw a sample with the transfer pipette, first squeeze and hold the top of the bulb. Insert the tip of 

the pipette into the liquid and release the bulb to draw sample up to fill line (see illustration). Transfer the 
pipette to the vial and squeeze the bulb to empty the sample into the vial.

2.	 Secure the cap on the water vial and shake vigorously for 30 sec.

Once the raw sample has been prepared properly, load the sample into the pouch.

Loading the RAZOR® EX Pouch

 CAUTION: In the following procedure, DO NOT push the syringe plunger to force liquid into the pouch. This 
can fill the pouch with air and may damage the pouch or cause contamination.

1.	 Confirm that the foil bag is air tight.

2.	 Open the foil bag and remove the freeze-dried reagent pouch from the aluminum can.

3.	 Place the pouch on a flat, clean surface with the inlet ports and label face up. Make sure the plunger comb 
is in place.

4.	 Uncap the end of a syringe and insert the tip end into reagent grade water or the sample.

5.	 Draw reagent grade water or the sample into the syringe until it reaches the mark for the appropriate vol-
umes. Avoid introducing any air into the syringe, which can cause bubbles.

6.	 Follow the prescribed order below to minimize cross-contamination and user error. Loading instructions are 
also found on the reagent pouch label.

Step 1

 Negative Controls 

Step 2

 Unknown Samples 

Step 3

 Positive  / Inhibition Controls
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Plunger (load 
position)

Plunger Comb

Sample Inlet 
Port

Freeze-dried
Reagent

Sample Slot

 Negative 
Controls

 Positive 
Controls

 Unknown 
Sample 2

 Unknown 
Sample 1

Yeast

Example Pouch with Key Parts Labeled

Sample Loading
Pouch Type Sample Volume

12 x 1 0.20 mL
6 x 2 0.35 mL
4 x 3 0.5 mL

10 + 2 2.0 mL
11 + 1 2.0 mL
1 x 12 2.0 mL

The procedure is essentially the same for loading the negative controls, the 
unknown sample, and the positive control: 

7.	 Load a syringe with the correct volume of sample. (See Table 1 above or 
the pouch assay card.)	

•	 For the Negative control inlet port and the Positive control inlet port, 
use the reagent grade water supplied in the reagent kit.

•	 For the Unknown Sample inlet ports and the Inhibition control inlet 
port (if present), use the unknown sample. 

8.	 Hold the syringe by the syringe body and gently insert the tip into the 
correct inlet port. Push the syringe down until you feel a faint pop and 
ease in resistance.

9.	 Allow the syringe to sit in the inlet port for at least 30 sec. to allow the liquid to dispense evenly.

After all of the syringes have emptied into the reagent pouch, confirm that each of the dried reagents are 
dissolved in the liquid. 

Dissolved reagents Undissolved reagents

If the reagents are dissolving slowly, shake the pouch gently by hand. 

Negative Control Inlet Port
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APPENDIX D: 
RAZOR EX INSTRUMENT 
PARTS AND TEST KITS

PARTS

The following table includes items that are packaged with the RAZOR EX instrument as well as 
items that are required and recommended to perform pathogen analysis. Descriptions and part 
numbers for these items have been included to make ordering easier. Please contact BioFire 
Defense to report defects in materials or manufacture. This will help us improve the quality or 
model of product offered.

Item Part Number
RAZOR EX Hybridization Probe System RAZR-ASY-4000
USB 2.0 Cable, 3.28' ft long RAZR-PRT-0080
RAZOR EX Operator's Manual RAZR-PRT-4018
Quick Guides (in Manual) RAZR-PRT-4019, -4020
Battery Recharger RAZR-SUB-4200
24 V 4 A Power Supply POWR-SUB-0022
Instrument Battery Pack RAZR-SUB-0009
Air Filter Assembly RAZR-SUB-0406
Power cord 110V POWR-CRD-0001
Power cord 220–230V POWR-CRD-0002
RAZOR EX Desktop Software RAZR-SCD-4000
Hard Carrying Case RAZR-CAS-0002
Instrument grab strap RAZR-SUB-0029
RAZOR EX Training CD RAZR-SCD-4001
RAZOR EX Training Manual RAZR-PRT-4024
Tool Kit

5 1/2" Needle Nose Pliers 5234
Lens Cleaning Solution 1803

Lens Cleaning Tissue 1802
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TEST KITS
The following RAZOR kits are available through BioFire Defense.

Item Part Number
RAZOR The 10® Target Screen Kit
Tests for ten pathogens (Anthrax, Brucella spp, Botulism A, Coxiella,  
E. coli O157, Tularemia, Ricin, Salmonella, Smallpox, and Plague) in 
one pouch.

PATH-ASY-0061

RAZOR BA 3 Target Kit

Tests for B. anthracis, Targets 1, 2, and 3
PATH-ASY-0007

RAZOR Food Screen 3 Target Kit

Tests for Campylobacter, L. monocytogenes, and Salmonella
PATH-ASY-0010

RAZOR Water Screen 3 Target Kit

Tests for Cryptosporidium Target 1, E. coli O157, and Salmonella
PATH-ASY-0011

TRAINING KITS
BioFire Defense offers several different training pouches for remaining proficient with your RAZOR 
EX or RAZOR instruments. Training kits contain all items that come in standard assay pouch kits. 
Training pouches are available in 11+1 or 4x3 formats allowing for training applicable to real-world 
scenarios.

Item Part Number
RAZOR Training Pouch (color dyes) and Sample Prep Kit

A 4x3 formatted pouch loaded with color dyes provides training on pouch 
loading procedures. With the color dyes, you receive instant feedback 
on loading techniques, for example, ensuring air bubbles are not loaded 
into the pouch. Note: the color dyes will not amplify on the RAZOR EX 
or RAZOR instrument.

PATH-ASY-0005

RAZOR Simulant Training Pouch (The 10®) and Sample Prep Kit

A 11+1 formatted pouch that mimics the format of The Ten® Target 
Screen. A yeast and a BG assay allow you to train in a real-world sce-
nario from sampling, pouch loading to running a RAZOR EX or RAZOR 
instrument complete with data analysis.

PATH-ASY-0091

RAZOR Yeast Kit and Sample Prep Kit

A 4x3 formatted pouch that mimics the format of the BA3, Food Screen 
and Water Screen Pouches. A yeast assay allows you to train in a real-
world scenario from sampling, pouch loading to running a RAZOR EX or 
RAZOR instrument complete with data analysis.

PATH-ASY-0006
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APPENDIX E: 
CHART PREFERENCES
By default, your user account includes an item called Chart preferences that determines the default 
appearance and content of your charts. You can change these default chart settings as needed. You 
can also save a modified version of a chart preferences item with a new name, then apply the pref-
erences in place of the defaults. You can have as many different chart preference items as you want, 
each one defining a different look and feel for your charts. For more information, see “Creating a 
Separate Preferences Item and Making it the Default,” in this section.
You can override the current chart preferences for individual charts, analyses, or tests.

 Opening the Chart Preferences Item
1.	 In the Navigator, open Preferences, located in your user folder.

2.	 Double-click Chart preferences to open the Chart preferences window.

The Chart preferences window is shown below.

Edit the settings you wish to change and select Save in the global toolbar to save your settings.
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Creating a Separate Preferences Item and Making It the Default
You can create multiple chart or sample preferences items, each with different settings, and then 
choose which one to use as the default. 
To save additional chart or sample preference items:

1.	 Open the Preferences folder.

2.	 Select the preferences item and right-click it. 

3.	 Select Copy. 

4.	 Enter a unique name for the preferences item, choose a location to save the item, and then 
select Save.

To make a preference item the default:

1.	 Open the preferences item you want to use as the default item.

2.	 In the title bar, select Make Default. The new settings are applied to the charts.

Overriding Default Chart Preferences 
In some cases, you may want an individual chart, analysis, or test to use different chart settings from 
the defaults specified in the Chart preferences item. You can override the default settings at the fol-
lowing levels: 

•	 On an individual chart 

•	 On all charts within an analysis 

•	 On all charts within a run 

When you specify custom settings at any of these three levels, the new settings take precedence 
over the default values for the charts at that level. 

To override chart preferences: 

1.	 Right-click the chart you want to modify 

 Or 
To override preferences for all charts within an analysis or within a run, right-click any chart in 
the test. 

2.	 Select Chart preferences 

A Chart preferences dialogue box opens that contains options for the chart type similar to those 
in the Chart preferences window described above. However, the dialogue box includes addition-
al options for setting the chart x- and y-axis scales. 
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3.	 In the Preferences level area at the bottom of the window, choose the level at which to override 
the current chart preferences: 

•	 Select the test name to apply the settings to all charts in the current run. 

•	 Select the analysis name to apply the settings to all charts in the current analysis. (You must 
have opened the menu from an analysis chart for this option to be available.) 

•	 Select Chart to apply the settings only to the current chart. 

4.	 Change text settings in the Title, Axis title, and Axis label boxes, as needed. 

5.	 Change the chart-specific settings (if any) in the box below the Title section. 

The options displayed depend on the type of chart that was active when you opened the dia-
logue box. For some chart types, there are no chart-specific settings. 

6.	 In the Axis scaling area, set the range of units for the chart’s x-axis and y-axis and the increment 
size. 

If you select 0 as the increment size, the increment size is determined automatically. If you set 
an increment size so small that the unit labels overlap, the setting is ignored, and the increment 
size is determined automatically. 

7.	 If you need to undo your changes and restore the previous values for the selected level, click 
Remove current values. 

8.	 When you are finished making changes, click Save. 
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Customizing Sample Names and Appearance
You can modify the appearance of sample lines and points on charts in two ways:

•	 You can modify the sample preferences that apply to all tests by modifying the default sam-
ple preferences item or creating multiple versions of the sample preferences and then apply-
ing the version you want.

•	 You can override the sample preferences for multiple samples in the current test or for an 
individual sample on a chart.

 Note: Only samples 1–12 apply to RAZOR EX runs. 

Modifying Default Sample Preferences for All Tests
By default, your user account includes an item called Sample preferences that determines the 
default sample names and the appearance of sample lines and points on all software charts. You 
can change the settings in the sample preferences item as needed. You can also save multiple ver-
sions of the sample preferences item and then apply the preferences you want. 

1.	 In the Navigator, double-click Sample preferences located under Preferences in your user 
folder.

The Sample preferences window is shown below.

2.	 To include or exclude a sample in the preview charts on the dialogue box, select or deselect the 
sample’s check box.

 Note: As you follow steps 3–8 below, remember that you can change settings for a contiguous 
group of samples at one time. To change settings for a group: 

a.	 Select the item you want to change for the first sample in the group.

b.	 Hold down the Shift key, then select the same item for the last sample in the group. 
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c.	 Press F2. 

d.	 Change the value for the first sample.

The changes are applied to all the selected samples.
3.	 To change a sample’s default color, click the colored square next to the sample name in the 

sample list to open a color palette, select the color you want, and then click OK. 

The sample color appears next to the sample name in test results and is used for sample lines 
and points in the charts.

4.	 To change the default sample name, click the sample name, and then type a new name.

The default sample name is applied to new test runs—existing runs are not affected.
5.	 To change the line style used for the sample, click in the Line Style column, and then select a 

new style from the pull-down list. 

6.	 To change the line width, click in the Width column, and then enter a new width.

7.	 If you prefer to see a sample line as a string of measurement points, click in the Point Style col-
umn, then select a style from the pull-down list. (If you prefer solid lines, leave the Point Style 
set to Nothing.)

8.	 Click Save in the global toolbar to save your settings.

Making a Sample Preferences Item the Default
1.	 Open the sample preferences item you want to use as the default item.

2.	 In the title bar, select Make Default. The new settings are applied to the charts.

Overriding Default Sample Preferences
At times you may want to change the appearance of samples in just one test without changing the 
defaults applied to all tests. You may also want to save the modified settings as a sample prefer-
ences item that can be applied to other test runs.

At the test level, you can:

•	 Use a sample preference editor to change the appearance of samples in the test run

•	 Apply an existing sample preferences item to a single test 

•	 Change the appearance of an individual sample line

•	 Save test settings as a sample preferences item

•	 Clear any changes and reapply the default sample preferences 

Using a Sample Preferences Editor to Override Sample Settings
1.	 Open the test that contains the sample settings you want to modify. 

2.	 Right-click on the chart that contains the sample information.

3.	 Select Sample preferences. 

A Sample preferences editor opens. 
4.	 Modify the settings, and then click Save.
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Modify the settings as you would if you were modifying the default sample preferences item. For 
more information, see “Modifying Sample Preferences for All Tests,” above.

5.	 Click Save in the global toolbar to save the test with the new settings. 

Your settings are applied to all the samples in the current test, but they do not affect other test 
runs or the default sample preferences settings. 

Applying a Different Sample Preference Item to an Individual Test to Override 
Sample Settings

1.	 Open the test that contains the sample settings you want to modify. 

2.	 Right-click on any of the charts that contains sample information.

3.	 Select Load Sample Preferences. 

4.	 Select a sample preferences item from the Navigator, and then select Open.

The settings are applied to all the samples in the current test, but do not affect other test runs or 
the default sample preferences settings. 

5.	 Select Save on the global toolbar to save the test with the new settings.

Saving Test Settings as a Sample Preferences Item
1.	 Open the test that has the settings you want to save as a sample preferences item.

2.	 Right-click a chart that contains sample information.

3.	 Select Save Sample Preferences.

4.	 Navigate to a location to save the sample preferences item, type a name for the item, and then 
select Save.

5.	 You can apply the new sample preferences item to individual tests, or you can make it the 
default item.

Reapplying the Default Sample Preferences to a Test with Overridden Settings
1.	 Open the test for which you want to reapply the default sample preferences.

2.	 Right-click on any of the charts that contains sample information.

3.	 Select Clear Sample Preferences.

The samples in the charts are reset to the current default sample preferences.
4.	 Select Save in the global toolbar to save the test with the settings.
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APPENDIX F: 
CERTIFICATIONS

CE CERTIFICATION

Declaration of Conformity

Manufacturer/
Supplier Information:

BioFire Diagnostics, Inc.
390 Wakara Way
Salt Lake City, Utah 84108, USA
Phone: 1-800-735-6544
it@BioFireDX.com
http://www.BioFireDX.com

Date of Issue: 03 JUNE 09

BioFire Diagnostics declares that the products:
Product Name: RAZOR EX

Description: Biodetection instrument using real time PCR.

To which this declaration relates, meets the protection requirements laid down in Council Directive 
73/23/EEC on low voltage equipment safety and 89/336/EEC on the alignment of the legal provisions 
of the Member States on electromagnetic compatibility (EMC).

To assess the product with regard to electromagnetic compatibility, the following relevant harmonized 
standards were applied:
EN 55022: 2006
Information technology equipment – Radio disturbance characteristics – Limits and methods of measurement
EN 55024: 1998
Information technology equipment – Immunity characteristics – Limits and methods of measurement
EN 61000-3-2: 2005
Electromagnetic compatibility (EMC) – Limits – Limits for harmonic current emissions (Equipment input current 
≤ 16 A per phase)
EN 61000-3-3: 2002
Electromagnetic compatibility (EMC) – Limits – Section 3: Limitation of voltage fluctuations and flicker in low-
voltage supply systems for equipment with rated current ≤ 16 A
EN 61010-1: 2001
Safety requirements for electrical equpiment for measurement, control and laboratory use - Part 1: General 
requirements

 
We hereby declare that the equipment named above has been designed to comply with the relevant 
sections of the above referenced specifications. The unit complies with all essential requirements of 
the Directives.
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R
T-

40
32

-0
1

CE Declaration of Conformity

Gina Bergman
Director of Quality Assurance and Regulatory 
Affairs

Brian Dorcheus
Manager of Instrument Production

390 Wakara Way, Salt Lake City, UT 84108
phone 1-801-736-6354 | fax 1-801-588-0507

www.BioFireDX.com
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APPENDIX G: 
BAR CODES

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: ITYEASTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0006

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: ITYEASTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0006

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: ITYEASTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0006

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: ITYEASTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0006

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: ITYEASTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0006

Scan this barcode into your RAZOR EX instrument
before running a test.


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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0006

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: ITYEASTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0006

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: ITYEASTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0006

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: ITYEASTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0006

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: ITYEASTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0006

ITYEASTB-YETB0001 ITYEASTB-YETB0002 ITYEASTB-YETB0003

ITYEASTB-YETB0004 ITYEASTB-YETB0005 ITYEASTB-YETB0006

ITYEASTB-YETB0007 ITYEASTB-YETB0008 ITYEASTB-YETB0009

ITYEASTB-YETB0010 ITYEASTB-YETB0011 ITYEASTB-YETB0012

ITYEASTB-YETB0013 ITYEASTB-YETB0014 ITYEASTB-YETB0015

ITYEASTB-YETB0016 ITYEASTB-YETB0017 ITYEASTB-YETB0018

ITYEASTB-YETB0019 ITYEASTB-YETB0020 ITYEASTB-YETB0021

ITYEASTB-YETB0022 ITYEASTB-YETB0023 ITYEASTB-YETB0024

ITYEASTB-YETB0025 ITYEASTB-YETB0026 ITYEASTB-YETB0027

ITYEASTB-YETB0028 ITYEASTB-YETB0029 ITYEASTB-YETB0030

RAZOR Yeast Pouch

ITFCTRNA-00000001 ITFCTRNA-00000002 ITFCTRNA-00000003

ITFCTRNA-00000004 ITFCTRNA-00000005 ITFCTRNA-00000006

ITFCTRNA-00000007 ITFCTRNA-00000008 ITFCTRNA-00000009

ITFCTRNA-00000010 ITFCTRNA-00000011 ITFCTRNA-00000012

ITFCTRNA-00000013 ITFCTRNA-00000014 ITFCTRNA-00000015

ITFCTRNA-00000016 ITFCTRNA-00000017 ITFCTRNA-00000018

ITFCTRNA-00000019 ITFCTRNA-00000020 ITFCTRNA-00000021

ITFCTRNA-00000022 ITFCTRNA-00000023 ITFCTRNA-00000024

ITFCTRNA-00000025 ITFCTRNA-00000026 ITFCTRNA-00000027

ITFCTRNA-00000028 ITFCTRNA-00000029 ITFCTRNA-00000030

Scan this barcode into your RAZOR EX instrument
before running a test.


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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: ITFCTRNA
'P

A
T

H
-P

R
T

-0
3
0
5
 R

e
v
 0

1

Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.


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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.


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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: ITFCTRNA

'P
A

T
H

-P
R

T
-0

3
0
5
 R

e
v
 0

1

Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0005

RAZOR Training Pouch  
(Color Dyes)

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0091

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0091

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0091

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0091

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0091

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0091

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0091

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0091

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0091

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0091

Simulant Training Pouch

10TARGTB-10TAR001 10TARGTB-10TAR002 10TARGTB-10TAR003

10TARGTB-10TAR004 10TARGTB-10TAR005 10TARGTB-10TAR006

10TARGTB-10TAR007 10TARGTB-10TAR008 10TARGTB-10TAR009

10TARGTB-10TAR010 10TARGTB-10TAR011 10TARGTB-10TAR012

10TARGTB-10TAR013 10TARGTB-10TAR014 10TARGTB-10TAR015

10TARGTB-10TAR016 10TARGTB-10TAR017 10TARGTB-10TAR018

10TARGTB-10TAR019 10TARGTB-10TAR020 10TARGTB-10TAR021

10TARGTB-10TAR022 10TARGTB-10TAR023 10TARGTB-10TAR024

10TARGTB-10TAR025 10TARGTB-10TAR026 10TARGTB-10TAR027

10TARGTB-10TAR028 10TARGTB-10TAR029 10TARGTB-10TAR030

RAZOR The 10®  
Target Screen Kit

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0008

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0008

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0008

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0008

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0008

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0008

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0008

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0008

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0008

Scan this barcode into your RAZOR EX instrument
before running a test.
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0008

BIOTRT1B-BIO1B001 BIOTRT1B-BIO1B002 BIOTRT1B-BIO1B003

BIOTRT1B-BIO1B004 BIOTRT1B-BIO1B005 BIOTRT1B-BIO1B006

BIOTRT1B-BIO1B007 BIOTRT1B-BIO1B008 BIOTRT1B-BIO1B009

BIOTRT1B-BIO1B010 BIOTRT1B-BIO1B011 BIOTRT1B-BIO1B012

BIOTRT1B-BIO1B013 BIOTRT1B-BIO1B014 BIOTRT1B-BIO1B015

BIOTRT1B-BIO1B016 BIOTRT1B-BIO1B017 BIOTRT1B-BIO1B018

BIOTRT1B-BIO1B019 BIOTRT1B-BIO1B020 BIOTRT1B-BIO1B021

BIOTRT1B-BIO1B022 BIOTRT1B-BIO1B023 BIOTRT1B-BIO1B024

BIOTRT1B-BIO1B025 BIOTRT1B-BIO1B026 BIOTRT1B-BIO1B027

BIOTRT1B-BIO1B028 BIOTRT1B-BIO1B029 BIOTRT1B-BIO1B030

BioThreat 1 Kit

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BIOTRT2B
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0009

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BIOTRT2B
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0009

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BIOTRT2B
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0009

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BIOTRT2B
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0009

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BIOTRT2B
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0009

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BIOTRT2B
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0009

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BIOTRT2B
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0009

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BIOTRT2B
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0009

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BIOTRT2B
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0009

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BIOTRT2B
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0009

BIOTRT2B-BIO2B001 BIOTRT2B-BIO2B002 BIOTRT2B-BIO2B003

BIOTRT2B-BIO2B004 BIOTRT2B-BIO2B005 BIOTRT2B-BIO2B006

BIOTRT2B-BIO2B007 BIOTRT2B-BIO2B008 BIOTRT2B-BIO2B009

BIOTRT2B-BIO2B010 BIOTRT2B-BIO2B011 BIOTRT2B-BIO2B012

BIOTRT2B-BIO2B013 BIOTRT2B-BIO2B014 BIOTRT2B-BIO2B015

BIOTRT2B-BIO2B016 BIOTRT2B-BIO2B017 BIOTRT2B-BIO2B018

BIOTRT2B-BIO2B019 BIOTRT2B-BIO2B020 BIOTRT2B-BIO2B021

BIOTRT2B-BIO2B022 BIOTRT2B-BIO2B023 BIOTRT2B-BIO2B024

BIOTRT2B-BIO2B025 BIOTRT2B-BIO2B026 BIOTRT2B-BIO2B027

BIOTRT2B-BIO2B028 BIOTRT2B-BIO2B029 BIOTRT2B-BIO2B030

BioThreat 2 Kit
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Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BA3TRGTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0007

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BA3TRGTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0007

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BA3TRGTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0007

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BA3TRGTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0007

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BA3TRGTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0007

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BA3TRGTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0007

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BA3TRGTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0007

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BA3TRGTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0007

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BA3TRGTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0007

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: BA3TRGTB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0007

BA3TRGTB-BA3TB001 BA3TRGTB-BA3TB002 BA3TRGTB-BA3TB003

BA3TRGTB-BA3TB004 BA3TRGTB-BA3TB005 BA3TRGTB-BA3TB006

BA3TRGTB-BA3TB007 BA3TRGTB-BA3TB008 BA3TRGTB-BA3TB009

BA3TRGTB-BA3TB010 BA3TRGTB-BA3TB011 BA3TRGTB-BA3TB012

BA3TRGTB-BA3TB013 BA3TRGTB-BA3TB014 BA3TRGTB-BA3TB015

BA3TRGTB-BA3TB016 BA3TRGTB-BA3TB017 BA3TRGTB-BA3TB018

BA3TRGTB-BA3TB019 BA3TRGTB-BA3TB020 BA3TRGTB-BA3TB021

BA3TRGTB-BA3TB022 BA3TRGTB-BA3TB023 BA3TRGTB-BA3TB024

BA3TRGTB-BA3TB025 BA3TRGTB-BA3TB026 BA3TRGTB-BA3TB027

BA3TRGTB-BA3TB028 BA3TRGTB-BA3TB029 BA3TRGTB-BA3TB030

RAZOR BA3  
Target Kit

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: WATRSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0011

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: WATRSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0011

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: WATRSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0011

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: WATRSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0011

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: WATRSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0011

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: WATRSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0011

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: WATRSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0011

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: WATRSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0011

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: WATRSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0011

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: WATRSCNB

P
A

T
H

-P
R

T
-0

2
9
3
 R

e
v 

0
1

Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0011

WATRSCNB-WATRB001 WATRSCNB-WATRB002 WATRSCNB-WATRB003

WATRSCNB-WATRB004 WATRSCNB-WATRB005 WATRSCNB-WATRB006

WATRSCNB-WATRB007 WATRSCNB-WATRB008 WATRSCNB-WATRB009

WATRSCNB-WATRB010 WATRSCNB-WATRB011 WATRSCNB-WATRB012

WATRSCNB-WATRB013 WATRSCNB-WATRB014 WATRSCNB-WATRB015

WATRSCNB-WATRB016 WATRSCNB-WATRB017 WATRSCNB-WATRB018

WATRSCNB-WATRB019 WATRSCNB-WATRB020 WATRSCNB-WATRB021

WATRSCNB-WATRB022 WATRSCNB-WATRB023 WATRSCNB-WATRB024

WATRSCNB-WATRB025 WATRSCNB-WATRB026 WATRSCNB-WATRB027

WATRSCNB-WATRB028 WATRSCNB-WATRB029 WATRSCNB-WATRB030

RAZOR Water Screen  
3 Target Kit

8TGTSCNB-8TGTB001 8TGTSCNB-8TGTB002 8TGTSCNB-8TGTB003

8TGTSCNB-8TGTB004 8TGTSCNB-8TGTB005 8TGTSCNB-8TGTB006

8TGTSCNB-8TGTB007 8TGTSCNB-8TGTB008 8TGTSCNB-8TGTB009

8TGTSCNB-8TGTB010 8TGTSCNB-8TGTB011 8TGTSCNB-8TGTB012

8TGTSCNB-8TGTB013 8TGTSCNB-8TGTB014 8TGTSCNB-8TGTB015

8TGTSCNB-8TGTB016 8TGTSCNB-8TGTB017 8TGTSCNB-8TGTB018

8TGTSCNB-8TGTB019 8TGTSCNB-8TGTB020 8TGTSCNB-8TGTB021

8TGTSCNB-8TGTB022 8TGTSCNB-8TGTB023 8TGTSCNB-8TGTB024

8TGTSCNB-8TGTB025 8TGTSCNB-8TGTB026 8TGTSCNB-8TGTB027

8TGTSCNB-8TGTB028 8TGTSCNB-8TGTB029 8TGTSCNB-8TGTB030

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: 8TGTSCNB

P
A

R
T

-N
U

M
-B

E
R

A
 R

e
v
 #

Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0056

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: 8TGTSCNB

P
A

R
T

-N
U

M
-B

E
R

A
 R

e
v
 #

Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0056

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: 8TGTSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0056

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: 8TGTSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0056

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: 8TGTSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0056

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: 8TGTSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0056

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: 8TGTSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0056

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: 8TGTSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0056

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: 8TGTSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0056

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: 8TGTSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0056

8 Target or CDN Screen Kit

FOODSCNB-FOODB001 FOODSCNB-FOODB002 FOODSCNB-FOODB003

FOODSCNB-FOODB004 FOODSCNB-FOODB005 FOODSCNB-FOODB006

FOODSCNB-FOODB007 FOODSCNB-FOODB008 FOODSCNB-FOODB009

FOODSCNB-FOODB010 FOODSCNB-FOODB011 FOODSCNB-FOODB012

FOODSCNB-FOODB013 FOODSCNB-FOODB014 FOODSCNB-FOODB015

FOODSCNB-FOODB016 FOODSCNB-FOODB017 FOODSCNB-FOODB018

FOODSCNB-FOODB019 FOODSCNB-FOODB020 FOODSCNB-FOODB021

FOODSCNB-FOODB022 FOODSCNB-FOODB023 FOODSCNB-FOODB024

FOODSCNB-FOODB025 FOODSCNB-FOODB026 FOODSCNB-FOODB027

FOODSCNB-FOODB028 FOODSCNB-FOODB029 FOODSCNB-FOODB030

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: FOODSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0010

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: FOODSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0010

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: FOODSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0010

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: FOODSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0010

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: FOODSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0010

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: FOODSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0010

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: FOODSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0010

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: FOODSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0010

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: FOODSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0010

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: FOODSCNB
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Consult the instrument manual or pouch
instruction booklet for additional information.

During  the  scan,  the  barcode  reader  will emit a
bright  green aiming beam surrounded by red light.
The  beam should be centered over the barcode in
any direction. Hold the barcode approximately 6–8
in. from the back of the instrument.

Kit Part Number: PATH-ASY-0010

RAZOR Food Screen  
3 Target Kit

GENERICB-GENB0001 GENERICB-GENB0002 GENERICB-GENB0003

GENERICB-GENB0004 GENERICB-GENB0005 GENERICB-GENB0006

GENERICB-GENB0007 GENERICB-GENB0008 GENERICB-GENB0009

GENERICB-GENB0010 GENERICB-GENB0011 GENERICB-GENB0012

GENERICB-GENB0013 GENERICB-GENB0014 GENERICB-GENB0015

GENERICB-GENB0016 GENERICB-GENB0017 GENERICB-GENB0018

GENERICB-GENB0019 GENERICB-GENB0020 GENERICB-GENB0021

GENERICB-GENB0022 GENERICB-GENB0023 GENERICB-GENB0024

GENERICB-GENB0025 GENERICB-GENB0026 GENERICB-GENB0027

GENERICB-GENB0028 GENERICB-GENB0029 GENERICB-GENB0030

Scan this barcode into your RAZOR EX instrument
before running a test.



Protocol Code: GENERICB
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Consult the instrument manual or pouch
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Generic Barcode

The GENERICB protocol can be used with both RAZOR-ASY-4000 and RAZR-ASY-4001. 
However, it requires REV 2 or higher of the RAZOR Master Controller Software. To check 
your instrument’s version, select Utilities from the RAZOR instrument’s main menu, then 
select View software vers. and scroll down to the master controller.
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Annealing: The second step in a PCR cycle where the primers bind the DNA sequence to initiate 
product extension. This step is optimized according to the melting temperature of the primers 
(i.e., 40–65ºC).

Conjugated (i.e., attached): Containing two or more double or triple bonds in alternation with 
single bonds. Used to describe a double chemical bond separated by a single bond.

DNA: Deoxyribonucleic acid. One of two types of molecules that encode genetic information. 
(The other is RNA. In humans DNA is the genetic material, and RNA is transcribed from it. 
In some other organisms, the reverse occurs: RNA is the genetic material, and DNA is tran-
scribed from it.)

Denaturation: The first step in a PCR cycle where the double-stranded DNA is melted at high 
temperature (92ºC) into single strands.

Excitation: The light energy transfer between the dyes on two hybridization probes in close prox-
imity when bound to a DNA strand.

FAM: 6-carboxyfluorescein. A fluorescence dye commonly used in hydrolysis probes.

Fluorescence Monitoring: Measurement of light emitted from a fluorescent probe.

Fluorescein (FITC): 5-carboxyfluorescein. Commonly used in hybridization probes.

F.R.E.T.: Fluorescence Resonance Energy Transfer. Light energy transfer between the dyes on 
two hybridization probes in close proximity when bound to a DNA strand.

Gel Electrophoresis: Separation of nucleic acid or protein through a matrix of either agarose or 
polyacrylamide by subjecting it to an electric field.

Hydrolysis Probes: These probes rely on the 5' exonuclease activity of Taq polymerase to cleave 
the DNA between two dyes. One dye is fluorescent, and the other dye acts as a fluorescence 
quencher. Cleavage of the DNA probe between these two dyes releases the fluorescent dye 
from quenching.

Hybridization Probes: These probes show an increase in FRET as product accumulates. One 
probe is labeled at the 5' end with a fluorescent dye, and, to avoid extension, modified at the  
3' end by phosphorylation. The second probe is labeled at the 3' end with a different fluores-
cent dye. Only after hybridization to the template DNA do the two probes come in close prox-
imity, resulting in FRET between the two fluorophores.

Inhibition: Interference with DNA amplification or detection of target sequences. 
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Inhibition control (IC): A positive control to which an unknown sample is added. Inhibition controls 
are considered a success if they amplify. The IC is used to determine the presence of inhibitors 
(agents such as bleach, EDTA, or ethanol), which might affect detection of target sequences. 

mL: Milliliter (1/1,000 of a liter). A unit of measurement for liquids. 

Negative control (NC): Contains all components needed for performing PCR, but does not con-
tain the nucleic acid target for which the unknown samples are being analyzed. A negative 
control is located separately from the unknown samples. If amplification occurs in the negative 
control, then the control fails. In this case, the negative control is contaminated, and unknown 
samples may also be contaminated

LED: Light emitting diode. Light source for fluorescing the probes in the samples.

PCR: Polymerase chain reaction.  A key technique in molecular genetics used to analyze and 
reproduce (amplify) selected short sequences of DNA (or RNA). Previously, amplifying was 
done in bacteria and took weeks. But now, with PCR done in capillaries, it takes less than  
30 min. The method is highly efficient so that untold numbers of copies can be made of DNA.

Positive control (PC): The positive control contains all components needed for performing PCR, 
including a target that should amplify. A positive control is located separately from the unknown 
samples, and its results apply to the unknowns in the run. If amplification does not occur in the 
positive controls, then the control fails.  

RNA: Ribonucleic acid. A nucleic acid molecule formed upon a DNA template and similar to DNA 
but containing ribose rather than deoxyribose. There are several classes of RNA molecules, all 
of which play crucial roles in protein synthesis and other cell activities.

TAMRA:  Tetramethyl, 6-carboxyrhodamine, a fluorescent dye commonly used as the quencher in 
5’ FAM/3’ TAMRA hydrolysis probes. TAMRA quenches the fluorescence of FAM until the probe 
hybridizes to the target and is cleaved by the 5’ exonuclease activity of the polymerase.

Transcription: The first step in carrying out genetic instructions in living cells wherein the genetic 
code is transferred from DNA to molecules of messenger RNA, which subsequently directs 
protein manufacture.

Translation: the process by which information in messenger RNA directs the sequence of amino 
acids assembled by a ribosome during protein synthesis.

Taq polymerase: Enzyme essential for PCR to occur. It “reads” the DNA sequence and facilitates 
the product extension by assembling each nucleotide.

µL: Microliter (1/1,000,000 of a liter). A unit of measurement for liquids.
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